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newsletters. 
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CORPORATION PROVIDES THIS MANUAL “AS IS” WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. Some 
states do not allow disclaimer of express or implied warranties in certain transactions. Therefore, 
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IBM does not warrant that the contents of this publication will meet your requirements or that the 
publication is error-free. 

Requests for copies of this publication and for technical information about IBM ® products should 
be made to your IBM Printing Systems Division Marketing Representative. 

IBM Printing Systems Division welcomes your comments.  For your convenience, a form for 
reader’s comments is provided at the back of this publication.  If the form has been removed, you 
may send your comments to the following address: 
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PO Box 1900 
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However, the following copyright notice protects this documentation under the Copyright laws of 
the United States and other countries that prohibit such actions as, but not limited to, copying, 
distributing, modifying, and making derivative works. 

© Copyright International Business Machines Corporation 1999, 2001. All rights reserved. 
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Notices 
References in this publication to products or services of IBM do not suggest or imply that IBM will 
make them available in all countries where IBM does business or that only products or services of 
IBM may be used. Noninfringing equivalents may be substituted, but the user must verify that 
such substitutes, unless expressly designated by IBM, work correctly. No license, expressed or 
implied, to patents or copyrights of IBM is granted by furnishing this document. You can send 
license inquiries, in writing, to the IBM Director of Licensing, IBM Corporation, 500 Columbus 
Avenue, Thornwood, NY 10594, USA. 

Licensees of this program who wish to have information about it for the purpose of enabling: (1) 
the exchange of information between independently created programs and other programs 
(including this one) and (2) the mutual use of the information, which has been exchanged, should 
contact: IBM Corporation, Printing Systems Division Legal Department, Mail Drop 001W, Boulder, 
Colorado 80301 USA. Such information may be available, subject to appropriate terms and 
conditions, including in some cases, payment of a fee. 

 
Trademarks 
IBM and Infoprint are registered trademarks or trademarks of IBM in the United States.   
Adobe and Acrobat are trademarks of Adobe Systems Incorporated, which may be registered in 
certain jurisdictions. 
Windows is a trademark of Microsoft Corporation in the United States and/or other countries. 
Other company, product and service names may be the trademarks or service marks of others. 
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About IBM Infoprint Scan and this book 
IBM Infoprint Scan is an application program you can use to scan hardcopy pages and assemble 
the pages into documents that can be viewed, enhanced, and submitted for printing. 

The Infoprint Scan program comprises two different pieces: the Advanced interface and the 
Copier interface.  Which interface you should use depends on your preference and skill level, 
document size and output volumes, and the complexity of your document scanning, 
enhancement, and printing requirements.  In keeping with the program, this guide is also divided 
into two parts: 

• Part I, beginning on page 3, describes how to use the Infoprint Scan Advanced interface.  
This piece of the Infoprint Scan program provides advanced capabilities for setting up your 
scanner and printer, as well as for document manipulation and image enhancement. 

• Part II, beginning on page 133, describes how to use the Infoprint Scan Copier interface, an 
alternative to the Advanced interface that you can use for high volume scanning and printing 
of documents with less complex setup and enhancement requirements.  Small (under 50 
sheets of paper), simple documents can be scanned and printed with one push of a button.  
This is a simplified version of the Infoprint Scan Advanced program that includes a copier-like 
interface that is designed for use with a touch screen monitor. 

Notes:  
• Detailed information about using the functions in both the Infoprint Scan Advanced and 

Copier interfaces can also be found in the online help that is provided with the program. 

• For you to carry out the procedures in this book, it is assumed that: 
− You have general knowledge of computers and the Windows operating system. 
− IBM Infoprint Scan 2000 is installed. 

or 
IBM Infoprint Manager for AIX and IBM Infoprint Scan are installed and configured to 
communicate with the Infoprint server. 

− A scanner is attached to the workstation where Infoprint Scan is installed. 
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Part I.  The Infoprint Scan Advanced Interface 
The procedures in Part I of this guide are applicable only when you are using the Infoprint Scan 
Advanced interface.  If it is available with your version of Infoprint Scan and you want to use the 
alternate Copier interface, refer to “Part II.  The Infoprint Scan Copier Interface,” beginning on 
page 133, for information. 

Working with scanned images can be a complex exercise.  The quality of your output is 
determined on a job-by-job basis, first by the quality of your hardcopy input, and then by how you 
manipulate the scanned pages before printing.  The following topics are provided in Part I to help 
you understand and carry out the procedures necessary to achieve the best results when you use 
the Infoprint Scan Advanced interface: 
• "Creating a new Infoprint Scan document" on page 7 
• "Setting up the scanner" on page 17 
• "Enhancing images in an Infoprint Scan document" on page 23 
• "Printing Infoprint Scan documents" on page 39 
• "Zoning pages in an Infoprint Scan document" on page 57 
• "Aligning pages in an Infoprint Scan document" on page 63 
• "Erasing areas from pages in an Infoprint Scan document" on page 67 
• "Adding text and page numbers to pages in an Infoprint Scan document" on page 71 
• "Resizing page images in an Infoprint Scan document" on page 77 
• “Trimming and cropping page images” on page 81 
• "Using Infoprint Scan cut, copy, and move functions" on page 85 
• "Modifying layers with Infoprint Scan" on page 95 
• "Adding and replacing pages in an Infoprint Scan document" on page 101 
• “Rotating contents of a page” on page 111 
• "Removing or deleting Infoprint Scan documents and pages" on page 113 
• “Backing up and restoring Infoprint Scan documents” on page 117 
• "Hints and tips" on page 119 

 

Before you begin 
Before you open Infoprint Scan and begin to use the Advanced interface, you need to be sure 
that your display screen is set up for optimal performance.  You need to: 
• Specify display screen properties, as described on page 4. 
• Maximize the Infoprint Scan display window, as described on page 5. 
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Specify display screen properties 
1. On your Windows desktop, click the right mouse button, and then click Properties in the pop-

up menu. 

 
2. In the Display Properties window, click the Settings tab and specify the following: 

• In the Color palette drop-down menu, select one of the following (depending on which is 
available in your menu): 
− True Color 
− 16777216 Colors 
− 32-Bit 

• Use the slide bar to specify 1280 x 1024 pixels for the screen resolution.   
(If this setting is not available for your display, use the highest setting that is available, 
such as 1024 x 768.).) 

• Select 70 Hertz in the Refresh Frequency drop-down menu. 
• Click the Test button. 

− In the Testing Mode window, click the OK button. 
− After a successful test, click the Yes button in the Testing Mode window in response 

to Did you see the bitmap properly? 

 
3. In the Display Properties window, click the OK button. 
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Maximize the Infoprint Scan display window 
You will also get the better results if you maximize the display window when you first open the 
Infoprint Scan Advanced interface: 
1. Open Infoprint Scan. 
2. In the Advanced interface main window, maximize the window by doing either of the 

following: 
• Click the Infoprint Scan icon, located in the left corner of the title bar, and then click 

Maximize. 
or 

• Click the Maximize button, located at the right of the title bar. 

    or     
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Creating a new Infoprint Scan document 
You can create a new Infoprint Scan document by using the program and an attached scanner to 
scan hardcopy original pages, by building a new document from existing TIFF (Tagged Image 
File Format) files, or a combination of both. 

Information is provided in the following topics: 
• "Scan a new Infoprint Scan document" on page 7 
• "Build a new Infoprint Scan document with TIFF files" on page 9 

 
Scan a new Infoprint Scan document 
Important! 
• If you are using Infoprint Scan as a stand-alone application, begin with step 1. 
• If Infoprint Manager is installed, and you have invoked Infoprint Scan from within the 

Infoprint Submit program, place your original hardcopy document in the scanner's 
document feeder, skip steps 1 through 4, and begin with step 5. 

To scan and create a new document: 

1. Open Infoprint Scan and place your original hardcopy document in the scanner's document 
feeder. 
• For the Fujitsu M4097D scanner, position the pages face down, inserting the sheets with 

the short edges leading.  
• For other scanners, refer to the manufacturer's instructions. 

2. Click File in the menu bar, and then click New Document.... 

 
3. In the Create New dialog box: 

a. Select the directory into which you want to save the scanned document. 
b. Type a name for the Infoprint Scan document in the File name field.  This name will also 

be used for the name of the job ticket when you submit the document for printing. 
Note: The file name cannot contain any of the following characters:  \ / : * ?< >| ’ “  

c. In the Save as type field, be sure Job Ticket Files (*.jtk) is selected. 

 
4. Click the Save button. 
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5. Click File in the menu bar, and then click Scan.... 

 
6. In the Original area of the Infoprint Scan document dialog box, select: 

• One-sided if the original hardcopy document is printed on just the front side of the paper.  
• Two-sided if the original hardcopy document is printed on both the front and back sides 

of the paper. 
(See "Scanning Two-Sided Originals" on page 119 for additional information about 
scanning two-sided documents.) 

 
7. Click the Change Settings button to view or change the scanner settings. 

(Refer to "Setting up the scanner" on page 17 for detailed information about scanner 
settings.) 

8. If your original hardcopy document contains a combination of text and graphic images, or just 
images with no text, be sure the Use Text and Image Mode check box is checked. 

9. If your original hardcopy document has a page size that is not listed among the scanner 
settings options, check the Custom Page size check box and enter the dimensions in the 
fields provided. 
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10. Check the Rotate 90 degrees clockwise after scanning check box, only if you want to 
change the orientation after the document has been scanned. 

11. Click the Scan button. 

12. When scanning has completed, the Append Scan Document dialog box will open. If you want 
to scan more pages to add to specified locations in the new document, place your hardcopy 
originals on the scanner, and repeat these instructions, beginning with step 5. 

 
13. Click the Close button in the Append Scan Document dialog box to return to the new, open 

document. 

14. If you also want to add one or more existing TIFF files to the new document, go to step 4 on 
page 10 of the "Build a new Infoprint Scan document with TIFF files" topic for information. 

15. When you are finished with this document: 
• Click File in the menu bar, and then click Close to close and save the document. 

or 
• Click File in the menu bar, and then click Exit to close and save the document and exit 

the Infoprint Scan application. 

 
Build a new Infoprint Scan document with TIFF files 
You can also build a new Infoprint Scan document without using a scanner at all. Use the 
following procedure to use TIFF files that were previously scanned using Infoprint Scan or TIFF 
files that were created with programs other than Infoprint Scan. You can add existing TIFF files 
selectively, or you can add all of the files contained in a particular directory. 

Note: If any of the files that you want to insert are read-only, keep in mind that you will not be 
able to use any Infoprint Scan functions that would result in a modification to the read-
only files (such as, image enhancement, page alignment, adding text, or any other 
editing). If you need to use these functions on the files or on the Infoprint Scan document 
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that will include the files, first change the files to read/write, or create and insert read/write 
copies of the original files. 

Important! 
• If you are using Infoprint Scan as a stand-alone application, begin with step 1. 
• If Infoprint Manager is installed, and you have invoked Infoprint Scan from within the 

Infoprint Submit program, skip steps 1 through 4, and begin with step 5. 

To use TIFF files to build a new Infoprint Scan document: 

1. Open Infoprint Scan. 

2. Click File in the menu bar, and then click New Document.... 

 
3. In the Create New dialog box: 

a. Select the directory into which you want to save the scanned document. 
b. Type a name for the Infoprint Scan document in the File name field. This name will also 

be used for the name of the job ticket when you submit the document for printing. 
Note: The file name cannot contain any of the following characters:  \ / : * ?< >| ’ “ 

c. In the Save as type field, be sure Job Ticket Files (*.jtk) is selected. 

 
4. Click the Save button. 

5. Click Page in the menu bar, and then click Add.... 

 

10   Using IBM Infoprint Scan  



 

6. To add one or more files selectively: 
a. Click the Add File button in the File Selection area of the Add Page dialog box. 

 
b. In the Open TIFF Files dialog box, locate the appropriate directory and highlight the file(s) 

you want to insert.  
(See "Selecting multiple files" on page 120 for information about selecting multiple files.) 

 
c. Click the Open button. 
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The highlighted file(s) will be added to the list box in the Add Page dialog box.  
(See "Using the Add Page list box" on page 120 for information about using the list box.) 
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7. To add all of the files in a directory: 
a. Click the Add Directory button in the File Selection area of the Add Page dialog box. 

 
b. In the Open directory to add files dialog box, select the directory that contains the files 

you want to insert. 

 
c. Click the Open button. 

The files contained in the highlighted directory will be added to the list box in the Add 
Page dialog box. If necessary, you can reorder the files or selectively remove individual 
files from the list. (See "Using the Add Page list box" on page 120 for information about 
using the list box.) 
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8. In the Add Page dialog box, select one of the following: 
• Append to end of current document - to add the TIFF file(s) at the end of the 

document that is currently displayed. The last added file will become the last page of the 
document. Multiple files will be processed in the order in which they appear in the list box, 
that is, from the top down. 

• Insert before current page - to add the TIFF file(s) in front of the page that is currently 
displayed. Multiple files in the list box will be processed in reverse order, so that the files 
are added one in front of the other, from the bottom of the list to the top of the list. 

• Insert after current page - to add the TIFF file(s) in back of the page that is currently 
displayed. Multiple files will be processed in the order in which they appear in the list box, 
that is, from the top down. 

• Replace current page - to insert the TIFF file(s) at the same location in the document as 
the page that is currently displayed, and delete the current page. For multiple files, the 
first file in the list will replace the current page and any subsequent files in the list will 
then be inserted after the current page. 

  
Notes: 
• The first time you add pages to a new document, it doesn't really matter which option 

is selected. Once the first page or pages have been added, you need to remember to 
select the appropriate location when you add additional pages. 

• When you use the Insert before current page, Insert after current page, and 
Replace current page options, keep in mind that when you insert a page, the new 
page becomes the current page. If you add additional pages, depending on which 
option you select, the next page scanned will be inserted before, after, or will replace 
the last page scanned. 
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9. In the Add Page dialog box, click the Done button to add the listed files and return to the 
open document, where the newly added pages will be displayed. 

You can now use image enhancement and other editing functions on the pages in the new 
document, with the exception of any read-only files you may have inserted. (See the Note on 
page 9 for additional information.) 

10. When you have finished with the open document: 
• Click File in the menu bar, and then click Close to close and save the open document. 

or 
• Click File in the menu bar, and then click Exit to close and save the document and exit 

the Infoprint Scan program. 
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Setting up the scanner 
There are no certain scanner settings that will guarantee the best quality output from your 
hardcopy original documents. You determine the settings you need for the best quality output on 
a job-by-job basis by estimating the quality of your input, and then by how the output appears on 
observation. The information in this section will explain your options to help you determine what 
settings you should use. 

Before you attempt to use your scanner with Infoprint Scan: 
• Be sure you have installed the scanner driver software. 
• The scanner must be powered on before your computer is powered on or the SCSI 

controller will not detect the scanner. If the scanner was not active when you last started 
your computer, shutdown the computer, power on the scanner, and then restart the 
computer. 

• Start Infoprint Scan, then:  

1. Click Options in the menu bar, and then click Select Scanner....  

 
2. In the Scanner Selections dialog box:  

• Highlight the name and type of scanner you are using. 
• Click the OK button. 

 

 
Viewing and modifying scanner settings 
Every scanner is different and has its own settings that control how pages are to be scanned. 
Infoprint Scan supports the industry standard ISIS scanner drivers that are provided by the 
scanner manufacturers. These drivers provide default scanner settings based on standard types 
of hardcopy originals. You can use the default settings or you can modify the settings as 
necessary to get the best quality output. 
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To view or modify scanner settings: 
1. Access the Scanner Settings dialog box: 

a. Open a new or an existing document. 
b. Click Options in the menu bar, and then click Scanner Settings.... 

 
or 

When you are in the process of scanning a new document or adding pages to an existing 
document, click File in the menu bar, and then click Scan....  

 
c. Click the Change Settings button in the Scan Document or Append Scan Document dialog 

box. 
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2. In the scanner settings dialog box for your scanner:  
a. Modify the settings as appropriate, or use the default settings.   

See ”Understanding and using the available scanner settings” on page 19 for additional 
information.  

b. To view or modify additional, advanced settings, click the More... button (if available).  
c. Modify the advanced settings as appropriate (or use the default settings), then click the 

OK button. 
d. When you are done, click the OK button in the scanner settings dialog box. 

Understanding and using the available scanner settings 
Every scanner is different and has its own driver that provides default settings for scanning 
standard types of hardcopy originals.  You can use the default settings or you can modify the 
settings: 

• Explanations of the settings that can be specified for the Fujitsu M4097D scanner are 
provided in “Fujitsu M4097D scanner settings” on page 19. 
Additional information about the Fujitsu M4097D scanner can be found in the documentation 
provided with the scanner. 

• For information about the settings that can be specified for any other scanner, refer to the 
documentation provided by the manufacturer of your scanner. 

Fujitsu M4097D scanner settings 
You can use the default settings for the Fujitsu M4097D scanner, or you can modify the settings 
to fit your requirements.  When you click the Change Settings button in the Scan Document or 
Append Scan Document dialog box (as described on page 18), the scanner settings dialog box 
will open, as shown in Figure 1 on page 19.  As you make modifications, keep in mind that you 
can restore the original, default settings at any time by clicking the Default button. 

 
Figure 1 .  Fujitsu M40970 scanner settings 
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You can specify values for the following settings for the Fujitsu M4097D scanner: 

• Mode - use this to select the type of output you want after scanning. Choices include:  

 
− Black and White - convert scanned images to black and white. 
− 256-Level Gray - keep scanned images as grayscale.  

• Dither - (Also known as digital halftoning.  Available only when Black and White Mode is 
selected.)  this is a way of representing different shades of gray with patterns of black dots 
and white space.  The illusion of shades of gray is accomplished with varying spacing and/or 
size of the black dots.  Only very advanced users should use these settings, if at all.  
Generally, you should not need to adjust the settings, as Infoprint Scan already performs the 
functions and is tuned for the specified output device. 

 
− None - use the default, no specified processing. 
− Pattern 1 through Pattern 4 – which pattern to select is based upon both the original 

image and the output device, and then testing through trial and error.  We suggest that 
you use the default (select the None option) rather than selecting any of these patterns. 

− Error Diffusion - creates a higher quality (and, therefore, larger) digital halftone.  This is 
similar to dithering, but uses an algorithm to determine what pixels should be black or 
white rather than using predefined patterns. 

− User Download – this can be used to download a user-defined dither pattern to the 
scanner. 

• Dots per inch - use this to specify the resolution at which you want to scan the document.  
The higher the scan resolution you set, the finer the detail, but be aware that a high resolution 
image requires much more memory space and processing time than a low resolution image.  
You will generally get high quality results if the scanning resolution is set as close as possible 
to the resolution of your output device.  A lower resolution will result in lower quality, and a 
higher resolution is a waste of memory.  
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• Page size - use this to specify the paper size of the hardcopy original.  

 

Note: If the size of your paper is not listed, and you need to define a custom paper size, 
you can do so in the Scan Document or Append Scan Document dialog box when 
you are scanning to create a new document or to append an existing document.  

• Brightness - use this to adjust the darkness control on the scanner. A high setting on the 
slide bar results in a lighter overall image, and a low setting results in a darker overall image.  
When you scan a dark image, the darker areas may appear as deep black, even though they 
contain gray shades.  Increasing the setting will cause the shades of gray to appear.  
Conversely, if a light image appears too white, decrease the setting.  Use the Darken, 
Normal, and Lighten buttons to adjust a light, normal, or dark image overall.  

 

• Contrast - use this to control the difference between the light areas and the dark areas of an 
image. A high setting on the slide bar emphasizes black and white, leaving few middle gray 
shades; a low setting emphasizes the middle gray shades, at the expense of black and white.  

 

• Page size - use this to specify the paper size of the hardcopy original.  

 

Note: If the size of your paper is not listed, and you need to define a custom paper size, you 
can do so in the Scan Document or Append Scan Document dialog box when you are 
scanning to create a new document or to append an existing document. 
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• Page Layout – use this to specify the orientation of the pages in the hardcopy original 
document, and indicates how text and images will be oriented on the output pages.  Choices 
are: 
− Portrait - the short edge is the top of the page. 
− Landscape - the long edge is the top of the page.  This option is only available when the 

B5 or Letter options are selected for Page Size. 

• Paper Source – use this option to indicate how the document will be input - using the 
automatic document feeder or the flatbed, or if the original document is duplex. 

 
• Side – use this to specify whether you are scanning both sides of the original document, or 

just the front or back side of the document. 

 

Note: If you click the More... button in the Scanner Settings dialog box, the Extra Features 
dialog box will open.  The options in the Extra Features dialog box are NOT available for 
you to use with Infoprint Scan. 
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Enhancing images in an Infoprint Scan document 
You can improve the appearance of a scanned document using Infoprint Scan's image 
enhancement functions.  Infoprint Scan provides a number of options that you can set for image 
enhancement.  There are no particular settings for these options that will guarantee the best 
quality output.  You determine the settings you need for the best quality output on a job-by-job 
basis by estimating the quality of your input, and by how the output appears on observation.  

You can specify the settings and have Infoprint Scan enhance images:  
• Immediately after the document is initially scanned.  
• On a document or specified pages of a document that has already been scanned.  
• When you add or replace pages in, or append pages to a scanned document.  

The information in this section will explain your options to help you determine what enhancement 
settings you should use.  Information is provided in the following topics: 

• "Enhancing images in an Infoprint Scan document" on page 23 
• "Enhance images in a previously scanned document" on page 28 
• "Selecting enhancement options" on page 30 
• "Enhancement options and settings" on page 33 

 
Enhance images when scanning a new document 
Important! 
• If you have invoked Infoprint Scan from within the Infoprint Submit program, place your 

original hardcopy document in the scanner, skip steps 1 through 4, and begin with step 5. 
• If you are using Infoprint Scan as a stand-alone application, begin with step 1. 

To scan and create a new document: 

1. Open Infoprint Scan and place your original hardcopy document in the scanner's document 
feeder. 
• For the Fujitsu M4097D scanner, position the pages face down, inserting the sheets with 

the short edges leading. 
• For other scanners, refer to the manufacturer's instructions. 

2. Click File in the menu bar, and then click New Document....  
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3. In the Create New dialog box: 
a.  Select the directory into which you want to save the scanned document. 
b. Type a name for the Infoprint Scan document in the File name field. This name will also 

be used for the name of the job ticket when you submit the document for printing. 
Note: The file name cannot contain any of the following characters:  \ / : * ?< >| ’ 

c. In the Save as type field, be sure Job Ticket Files (*.jtk) is selected.  

 
4. Click the Save button. 

5. Click File in the menu bar, and then click Scan.... 
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6. In the Original area of the Scan Document dialog box, select: 
• One-sided if the original hardcopy document is printed on just the front side of the paper. 
• Two-sided if the original hardcopy document is printed on both the front and back sides 

of the paper. See "Scanning Two-Sided Originals" on page 119 for additional information 
about scanning two-sided originals.  

 
7. Click the Change Settings button to view or change the scanner settings.  

(Refer to "Setting up the scanner" on page 17 for detailed information about scanner 
settings.) 

8. If your original hardcopy document contains a combination of text and graphic images, or just 
images with no text, be sure the Use Text and Image Mode check box is checked. 

9. If your original hardcopy document has a page size that is not listed among the scanner 
settings options, check the Custom Page size check box and enter the dimensions in the 
fields provided. 

10. Check the Rotate 90 degrees clockwise after scanning check box, only if you want to 
change the orientation after the document has been scanned. 

11. Click the Scan button. 
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12. When scanning has completed, the Append Scan Document dialog box will open. If you want 
to scan more pages to add to specified locations in the new document, place your hardcopy 
originals on the scanner, and repeat these instructions, beginning with step 5. 

 

13. Click the Close button in the Append Scan Document dialog box to return to the new, open 
document. 

14. If you will be enhancing the image on just one page, make that page the current page.  For 
information about going to a particular page, see "Navigating through an Infoprint Scan 
document" on page 121. 

15. Click Tools in the menu bar, and then click Enhance.... 
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16. See "Selecting enhancement options" on page 30 for information about the options in the 
Enhance Image dialog box. 

 
Note: You can use the Undo Enhance option in the Tools menu to reverse only the most 

recent image enhancement operation performed on a page or pages in the open Scan 
document.  Image enhancements cannot be undone and the option will not be 
available after any changes to the document have been saved or after the document 
has been closed and reopened. 

17. After the image enhancement has completed, click File in the menu bar, and then click Close 
to close and save the document, or Exit to close and save the document and exit the 
Infoprint Scan application. 
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Enhance images in a previously scanned document 
To enhance the images in a document that has been previously scanned: 

1. Invoke Infoprint Scan and click File in the menu bar, and then click Open... to open the 
Infoprint Scan document that you want to enhance. 

 
2. If you will be enhancing the image on just one page, make that page the current page.  For 

information about going to a particular page, see "Navigating through an Infoprint Scan 
document" on page 121. 

3. Click Tools in the menu bar, and then click Enhance.... 

 
4. See "Selecting enhancement options" on page 30 for information about the options in the 

Enhance Image dialog box. 

Note: You can use the Undo Enhance option in the Tools menu to reverse only the most 
recent image enhancement operation performed on a page or pages in the open Scan 
document.  Image enhancements cannot be undone and the option will not be 
available after any changes to the document have been saved or after the document 
has been closed and reopened. 
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5. After the image enhancement has completed, click File in the menu bar, and then click Close 

to close and save the document, or Exit to close and save the document and exit the 
Infoprint Scan application. 
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Selecting enhancement options 
You can select the enhancement options that you want Scan to perform when a new or 
previously created Infoprint Scan document is open, as described in:  

• "Enhance images when scanning a new document" on page 23 
• "Enhance images in a previously scanned document" on page 28  

With an Infoprint Scan document open, do the following: 

1. Click Tools in the menu bar, and then click Enhance....  

 
2. Select one of the following in the Apply to area of the Enhance Image dialog box:  

• Current page - to apply the enhancements only to the page that is currently displayed.  
• Document - to apply the enhancements to the document as specified with:  

− All Pages - to apply the enhancements to all pages in the document. 
− Even Pages - to apply the enhancements to all even-numbered pages.  
− Odd Pages - to apply the enhancements to all odd-numbered pages.  

• Pages _________ - to apply the enhancements to a specific page or pages, or to a 
range of pages. 
− For an individual page, type the page number of the page you want to print in the 

field provided. 
− For specific pages, type the numbers of all of the pages you want to print, each 

separated by a comma (such as, 3,9,11,24). 
− For a range of pages, type the number of the first and last pages you want included, 

separated by a dash (such as, 15-20). 
− You can also specify individual pages along with a range of pages (such as, 

3,9,11,24,15-20). 
− Do not include spaces after the commas. 
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3. Click the Change Settings button to modify the enhancement settings. It is important, if you 
are going to modify the enhancement settings, that you do so before executing the 
enhancement options that you will select in the next step.  See "Enhancement options and 
settings" on page 33 for information.  

4. In the Enhance Options area, you can select the following options: 
Note: Any or all of the enhancement options can be selected at one time. 

(See "Enhancement options and settings" on page 33 for additional information about 
each of the options.) 

• Deskew - adjusts and corrects the angle at which a document is skewed, so the page 
and lines are aligned properly. 
(See "Fixed Image Size" on page 38 for important information related to using Deskew.) 

• Despeckle - removes isolated, unwanted specks that may occur during scanning. 
• Auto-Crop - eliminates an edge or border around a page that does not match the rest of 

the page. 
• AutoRotate Portrait - when this is selected, if Scan finds a page of text that is upside 

down, it will automatically rotate the page, so that the text is right side up. 
• Registration Vertical - positions text and data vertically on the page to provide 

consistent side margins. 
• Registration Horizontal - positions text and data horizontally on the page to provide 

consistent top margins. 
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See "Registration tips" on page 37 for additional information about using the Registration 
options. 

• Sand and Fill - smoothes the edges of characters by filling in small pits and removing 
small bumps. Applying this option will improve the appearance of characters and reduce 
the compressed image file size. 

• Invert Image - reverses the image so that all blacks are white and all whites are black. 
On a "positive" image, the effect is similar to that of a photographic negative, shown in 
Figure 2. (Conversely, a negative image is made positive.) 

 

   
Figure 2. The entire page image is inverted. 

Notes: 
− This function works only on the image of the entire page - if you want to reverse the 

image in just a specified area of the page, use the Invert Layer option in the Edit 
menu. For additional information, refer to page 97 of the "Modifying layers with 
Infoprint Scan" topic. 

− If you have selected Invert Image along with other enhancement options, such as 
despeckle and auto-crop, Scan will perform the other enhancements first, and then 
will invert the image.   
Important! The one exception to this is if you have selected Perform enhance on 

inverse of image in the Enhance Settings dialog box, as described on 
page 38.  When this option is selected, all enhancements will be done on 
the inverted image, and then the image will remain inverted. 

• Rotate - rotates pages by a specified number of degrees from their current orientation.  
Options include:  

 
− None - do not rotate the page  
− 90 Degrees Clockwise -rotate the page 90 degrees clockwise (1/4 turn) from the 

current orientation. For example, this would cause a portrait (vertical) page to display 
or print in a landscape (horizontal) format. 
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− 180 Degrees Clockwise - rotate the page 180 degrees clockwise (1/2 turn) from the 
current orientation. For example, a portrait (vertical) page would display or print with 
the head and foot areas of the page in reversed positions.  

− 270 Degrees Clockwise - rotate the page 270 degrees clockwise (3/4 turn) from the 
current orientation. For example, a landscape (horizontal) page would display or print 
with the head and foot areas of the page in reversed positions.  

(See "Fixed Image Size" on page 38 for important information related to using Rotate.) 

5. Click the Enhance button to enhance the image(s) based on the default or your modified 
settings. 

Undoing image enhancements 
You can reverse only the most recent image enhancement operation performed on a page or 
pages in an open Scan document. 

Note: Image enhancements can no longer be undone and the option will not be available after 
any changes to the document have been saved or after the document has been closed 
and reopened. 

To undo the most recent image enhancement, click Tools in the menu bar, and then click 
Undo  Enhance. 

 

 
Enhancement options and settings 
The following information describes the image enhancement options that are available and to 
help you determine what values to set for these options. 

• Enhancement options are provided on the Enhance Image dialog box, which you access from 
the Tools menu. 

 
• The settings that determine how selected image enhancements will be performed are located 

on the Enhance Settings dialog box.  You can access the Enhance Settings dialog box either 
by clicking the Change Settings button while in the Enhance Image dialog box (as shown in 
Figure 3 on page 34), or from the Options menu. 
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Figure 3. You can access enhance settings from the Enhance Image dialog box or from the 
Options menu.       

FYI: You will notice that the term “pixel” is used as a unit of measure on the Enhance Settings 
dialog box.  In case you're not familiar with the term, a pixel is another word for pel, or 
picture element. This is defined as the smallest scanable, printable, or displayable unit on a 
physical medium or display surface.  PPI (pixels or pels per inch) is often used as a 
measurement of presentation granularity. 

Deskew  
Deskew adjusts and corrects the angle at which a document is skewed, so the page and lines will 
be aligned properly. Skew is the position of paper going through the scanner's paper path at a 
slight angle, causing the scanned lines to not be aligned properly. 

Deskew settings 
In the Enhance Settings dialog box, move the slide bars in the Deskew Sensitivity area left to 
increase the values or right to decrease the values. 

 
• Acceptable Skew - sets the maximum amount of skew that is accepted. Any image with less 

skew than the set value will not be corrected. Lowering the value will cause more images to 
be corrected, and raising the value will cause fewer images to be corrected. Setting to a 
lower value will result in higher scanning speed, since more images are left as is. For 
example, the original default setting is 0.671%. This results in an image with no more than 
150 horizontal pixels for each vertical pixel of skew. A lower setting of 0.5% results in an 
image with no more than 200 horizontal pixels for each vertical pixel of skew, and a higher 
setting of 1% results in an image with no more than 100 horizontal pixels for each vertical 
pixel of skew. 
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• Detection length - indicates the shortest line, in pixels, to be used to detect skew. This value 
should be at least 25% larger than Acceptable Skew. The original default is 300 (1 inch at 
300 dpi). 

See "Fixed Image Size" on page 38 for important information related to using Deskew. 

Despeckle  
Despeckle removes isolated, unwanted specks that may occur during scanning. 

Despeckle settings 
In the Enhance Settings dialog box, move the slide bars in the Despeck Sensitivity area right to 
increase the values or left to decrease the values. 

 
• Isolated size - determines the size of isolated specks that are removed. Larger values can 

cause periods and the dots on letters such as j to be removed. The original default is 4. 
• Vertical size - examines each vertical line 1 pixel wide and deletes all groups of pixels with a 

length less than the value specified. Larger values will remove larger specks. If the value is 
too high small segments of characters will be removed. The original default is 0. 

• Horizontal size - examines each horizontal line 1 pixel wide and deletes all pixels with a 
length less than the value specified. Larger values will remove larger specks. If the value is 
too high small segments of characters will be removed. The original default is 0.  

Cropping  
Cropping eliminates an edge or border around a page that does not match the rest of the page. 
For example, if you have specified that your Infoprint Scan document will print on an 8.5 inch x 11 
inch page, but the original hardcopy document is smaller than 8.5 x 11 inches, without cropping, 
you would get black borders on the scanned pages, the width of the difference in size between 
the original pages and the scanned pages. With Auto-Crop turned on (selected) Scan will 
automatically eliminate the unwanted borders. 

Auto-Crop settings 
In the Enhance Settings dialog box, click the arrow in the Cropping area and highlight an Auto-
Crop option. 
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• Auto-Crop - specifies the color of unwanted borders or edges that are to be eliminated from 
pages. Choices are:  
− Crop Black - Scan will eliminate black borders or edges from around pages. This is the 

original default. 
− Crop White - Scan will eliminate white borders or edges from around pages.  

Registration  
Registration is used for page alignment. With this tool, you can position text horizontally and 
vertically on the page to provide consistent side and top margins. 

Registration settings 
In the Enhance Settings dialog box, in the Registration area, type the values you want for the left 
and top margins, and select or deselect the Central Focus and Add Only check boxes. 

 
• Resultant Bind Margin - determines how many pixels will remain as the bind margin (for a 

two-page spread - or facing pages - the left margin on an odd-numbered page, or the right 
margin on an even-numbered page) after processing. Scan locates the bind edge of the text 
or data and positions the bind edge of the image the specified number of pixels from the bind 
edge of the text or data. Setting this value to 0 places the text or data flush with the bind edge 
of the image. A negative value crops the specified number of pixels from the bind edge of the 
text or data. 

• Resultant Outer Margin - determines how many pixels will remain as the outer margin (for a 
two-page spread - or facing pages - the right margin on an odd-numbered page, or the left 
margin on an even-numbered page) after processing. Scan locates the outer edge of the text 
or data and positions the outer edge of the image the specified number of pixels from the 
outer edge of the text or data. Setting this value to 0 places the text or data flush with the 
outer edge of the image. A negative value crops the specified number of pixels from the outer 
edge of the text or data. 

• Resultant Top Margin - determines how many pixels will remain as a top margin after 
processing. Scan locates the topmost edge of the text or data and positions it a fixed distance 
from the top edge of the image. Setting this value to 0 places the text or data flush with the 
top edge of the image. A negative value crops the specified number of pixels from the top 
edge of the text or data. 

• Central Focus - causes Scan to register using only the middle portion of the image border. 
This is useful for ignoring edge noise, letterheads, and logos. You can activate this for the 
resultant bind margin, the resultant outer margin, the resultant top margin, any or all of these 
margins at one time, or none of the margins. 

• Add Only - causes Scan to expand the current margin (if it is smaller than the specified 
value) to the size specified for the Resultant Bind, Outer, or Top Margin. You can activate this 
for the resultant bind margin, the resultant outer margin, the resultant top margin, any or all of 
these margins at one time, or none of the margins.  
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Determining pixel values  
To determine the value in pixels to enter for the resultant bind, outer, and top margins, multiply 
the dimension you want for the margin by the scanned resolution of the image. 
Example: 
As an example, let's say you want to center the body of text on a 6-inch wide x 9-inch long page, 
so that both the bind and the outer margins are the same. Assume that you have scanned the 
image at 600 dpi. 
1. Measure the line length of the text, using the longest line on the page. For this example, 

assume that the line length is 4.5 inches. 
2. Subtract the line length from the width of the page. 

6.0 inches – 4.5 inches = 1.5 inches 
This leaves a total of 1.5 inches for the margins.  

3. Since there are two margins, divide the remainder by 2. 
1.5 inches ÷ 2 = .75 inch 

For this example, the resultant margins are each .75 inch. 
4. To convert this to pixels, multiply the width of each margin by the scanned resolution (600 dpi 

for this example). 
.75 inch x 600 dpi = 450 pixels 

5. For this example, you would enter 450 for the value in both the Resultant Bind Margin and 
Resultant Outer Margin fields. 

Note: Remember to adjust the values if you want a wider bind margin than outer margin, to allow 
additional room for 3-hole punching, saddle stitching, or other types of binding. For 
example, if you want the bind margin to be 1 inch, and the outer margin to be .5 inch, for 
an image scanned at 600 dpi the resultant bind margin will be 600 pixels (1 inch x 600 
dpi), and the resultant outer margin will be 300 pixels (.5 inch x 600 dpi). 

Registration tips 
• When you use Registration, you should also activate Deskew unless you know that the 

original is perfectly straight. 
• You can activate and set the parameters for horizontal (bind and outer edges of an image) 

and vertical (top edge) registration separately. 
• For most operations where you require consistent bind and outer margins, you should 

activate horizontal registration. In many cases, you can leave vertical registration deactivated. 
For applications where precise text location is important, you should activate both horizontal 
and vertical registration. 

• When you have finished specifying all of the settings, click the Save button in the Enhance 
Settings dialog box. 

• To return all of the settings to their original defaults, click the Default button in the Enhance 
Settings dialog box.  
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Fixed Image Size 
• Do not allow Enhance to modify image size - If this check box is not selected, Enhance 

will proportionally resize the image, when necessary, to fit on the page.  When the box is 
selected (checked), Enhance will not resize the image. 
− Be sure to check this box when Deskew is selected. 
− Be sure that this box is not checked when you have selected to Rotate the image and 

want the entire image to fit on the rotated page (such as when an image with a portrait, or 
vertical orientation is rotated 90 or 270 degrees to a landscape, or horizontal orientation). 

 

• Perform enhance on inverse of image - Select (check) this box when you want Infoprint 
Scan to use the inverse, or negative of the page image(s) when carrying out the selected 
enhancements.  Scan will internally perform the enhancements on the inverted image, and 
then will return the image to its original state.   
The exception to this is if you have selected Invert Image in the Enhance Image dialog box, 
as described on page 32.  When both options are selected, the enhancements will be 
performed on the inverted image, and then the image will remain inverted. 
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Printing Infoprint Scan documents 
Note: Printing options are not available when Infoprint Scan is invoked from within the Infoprint 

Submit program.  For information about submitting print jobs from within the Infoprint 
Submit program, refer to the online help that is provided with that program.  The following 
information is applicable only when you use Infoprint Scan as a stand-alone application, or 
when you use Infoprint Scan 2000. 

You have some options for how to print scanned documents from Infoprint Scan.  Depending on 
how your system is set up, you can: 
• Print Infoprint Scan documents on a locally attached printer 

Information begins on page 40. 

or, when Infoprint Manager is installed, you can: 
• Submit a print job to the Infoprint server for printing. 

Go to page 41 for information. 

Alternately, you can: 
• Export an Infoprint Scan document as a PDF file that can be viewed online or printed. 

Go to page 53 for information. 

Note: The Export function is always available when there is an open document in Infoprint 
Scan, including when Scan is invoked from within the Infoprint Submit program. 

Go to "PDF files" on page 55 for some information about PDF files and PCL drivers that can help 
you decide when to use local printing, and when to use the Export function. 
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Print Infoprint Scan documents on a locally attached printer 
You can use your Windows printer drivers to select the Infoprint 2000, or, if applicable, another 
printer that is attached directly to your workstation or to a LAN. 

To print on a locally attached printer: 

1. With a scanned document open and displayed in the Infoprint Scan main window, click File in 
the menu bar, and then click Print.... 

 
2. In the Windows Print dialog box, select the printer in the Name field, and set other options 

and properties, as applicable.  

 
3. Click OK to print the scanned document. 
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Submit a print job to the Infoprint server 
When you have Infoprint Manager installed, you can submit a print job to the Infoprint server, 
where it will be scheduled for printing. This also allows you to define and modify print and RIP 
options and to check print status. 

Note: To submit a print job to the Infoprint server, you must have Infoprint Manager installed. If 
you are using Infoprint Scan 2000 without Infoprint Manager, go to "Print Infoprint Scan 
documents on a locally attached printer" on page 40 or "Export an Infoprint Scan 
document as a PDF file" on page 53 for instructions. 

When you submit a job to the Infoprint server for printing, you open the Scan Print dialog box 
where you can set print options, RIP options, retention times, and specify how the document 
should look when it is printed. Refer to the following topics for information about submitting a 
Scan print job: 
• "Submitting a job" on page 42 
• "Setting options for the Infoprint Scan document print job" on page 43 

You can also set your preferences (default values) for printing, page layout, and schedules, 
update your printing options, and check on the status of your submitted print jobs. For more 
information, refer to: 

• "Setting preferences" on page 47 
• "Refreshing printing options" on page 51 
• "Checking print job status" on page 51  
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Submitting a job 

To submit a job to the Infoprint server:  

1. With a scanned document open and displayed in the Infoprint Scan main window, click File in 
the menu bar, and then click Submit Job.... 

 
2. Set options for the job in the Scan Print dialog box. This dialog box contains three tabbed 

pages where you can set print options, RIP options, retention times, and specify how the 
document should look when it is printed.  

"Setting options for the Infoprint Scan document print job on page 43 describes the attributes 
that can be set for Print, Schedule, and Layout. 

3. When you have finished setting the options for Print, Schedule, and Layout, click OK to 
submit the document for printing.  
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Setting options for the Infoprint Scan document print job 
 When you submit a job to the Infoprint server for printing, you open the Scan Print dialog box, 
which contains three tabbed pages:  
• From the Print page, you can change and select print options.  
• From the Schedule page, you can specify RIP options, retention times, and print priority.  
• From the Layout page, you can specify how the document should look when it is printed.  

The available options will change, depending upon which tab is selected. 

Setting Print options 
Click the Print tab in the Scan Print dialog box to set these options: 

 
• Description - Type a description for the job ticket. The text can consist of of alphabetic or 

numeric characters. This field is optional.  
• Printer type - Select the type of printer you want to use for printing the Infoprint Scan 

document. 
(Use Preferences from the Options menu to set the default value for this option.) 

• Printer - Select the name of the printer you want to use for printing. The printer names listed 
are logical printers as defined to the server. The printers listed are all of the types specified 
for Printer type. 

• Copies to Print - Specify the number of copies to print. Type a number or click the up and 
down arrows to specify the number you want. 

• Proof, do not optimize for multiple copies - use this to save time when printing multiple 
proof copies on the Infoprint 4000. When checked, optimizes for a single copy on the Infoprint 
4000; the pages are not saved at the printer and will be loaded for each copy printed. When 
not checked, the pages are saved at the printer and are not loaded for each copy printed.  
Available only when the Infoprint 4000 is specified as the Printer Type. 
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• Pages to Print - Specify which pages in the document you want to print. Select from the 
following:  
− All - Prints all of the pages in the document. 
− Pages - You can specify a page, specific pages, or range of pages to print. Type the 

page(s) and/or page range in the field provided.  
• Print Job ID - Specifies the job ID of the print job. The Job ID is composed of the string 

Scan, followed by a suffix that indicates the number of times the job was submitted. The 
suffix is incremented by one each time you submit a job with this job ID. This is a read-only 
field. 

• Paper - Select the paper to use when printing the document. The list of available paper types 
is based on the printer you selected in the Printer type field. 

• Stacker - Select the output stacker for printed output on your Infoprint 60. 
(Use Preferences from the Options menu to set the default value for this option.) 
Available only when the Infoprint 60 is specified as the Printer Type. 

Setting Schedule options 
Click the Schedule tab in the Scan Print dialog box to set these options: 

 
• RIP Options - Specifies processing instructions to the server before printing. Select from the 

following: 
− Use server default - uses the Infoprint server's default setting. 
− Hold - holds the job at the server until you release it for printing. 
− Rip Only - RIPs the data without printing or holding the job. Error messages are sent 

from the server to the Message window only if you specify a Retain value; otherwise, no 
messages are returned from the server. 

− Rip then hold - RIPs the data and holds the job at the server until you release it for 
printing. 

− Print -RIPs the data (if needed) and prints the job. (Use Preferences from the Options 
menu to set the default value for this option.) 
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• Retain job at server - Specifies whether to retain the document on the server after printing. 
Select from the following:  
− Do not retain at server - specifies that the print job not be retained at the server. Job 

status messages are not returned to the Job Message window when you select this 
option. Click another option to deselect this option.  

− Retain for __ Hours or Days - when you select the Retain for option, the time and units 
fields are made available. Use the time and units fields to set the retention period for the 
job at the server. Type a number in the field provided and select Hours or Days. The 
default value is 1 day. Click another option to deselect this option.  
(Use Preferences from the Options menu to set the default value for this option.) 

Note: Storing documents on the server takes up space on the hard drive and should be 
done conservatively and only temporarily. 

• Priority - Determines the order of importance for printing the document. Type or select a 
number to specify the priority of the job. Valid values are numbers from 1 to 10 (10 is the 
highest priority).  
(Use Preferences from the Options menu to set the default value for this option.)  

Note: Documents having the same priority will print on a first come, first served basis. 

• Output appearance - Specifies the output appearance (or style) for the document, and is 
used to determine the dark and light levels when halftoning TIFF grayscale data. Select from 
the following:  
− Use server default - uses the Infoprint server's default setting.  
− Standard  
− Highlight midtones - shows more levels of gray (more contrast in the middle tones, less 

for the most dark and most light).  
− Dark - makes halftones print darker overall.  

(Use Preferences from the Options menu to set the default value for this option.) 

• Screen frequency - Specifies the screen frequency value, or resolution of the halftone 
screen that is used for halftoning TIFF grayscale data. Select from the following:  
− Use server default - uses the Infoprint server's default setting  
− 71 
− 85 
− 106 
− 141  
(Use Preferences from the Options menu to set the default value for this option.) 
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Setting Layout options 

Click the Layout tab in the Scan Print dialog box to set these options: 

 
• Layout - Specifies the output format (or page layout) you want to use for printing the 

document. 
(Use Preferences from the Options menu to set the default value for this option.) 

• Sides - Specifies the sides of the paper on which a document is to be printed. This field is not 
available when booklet 2-up is selected for Layout and when a form definition is used. Select 
from the following:  
− Use server default - uses the Infoprint server's default setting.  
− Simplex - prints on one side of the paper.  
− Duplex - prints on both sides of the paper.  
− Tumble - prints on both sides of the paper so that the top of one side of the sheet is at 

the same end as the bottom of the other side. Sometimes referred to as "head-to-foot" 
printing.  
Tip: Keep in mind that if the hardcopy document was originally printed and also scanned 
with a tumbled arrangement of pages, and you want to keep the tumbled arrangement for 
printing now, you should not specify Tumble for the Sides value. Tumble causes every 
other page of the document to be rotated 180 degrees. If the document is already 
tumbled, the Tumble option will "untumble" it when it is printed. Verify the sides 
arrangement of your document by scrolling through the pages in the display area of the 
main Infoprint Scan window.  
° If every other page is rotated 180 degrees, and you want this document to be 

printed head-to-foot, do not specify Tumble - instead, specify Duplex to print the 
scanned document exactly as it is displayed.  

° Conversely, if every other page is already rotated 180 degrees, and you want to 
"untumble" the document so that it now prints with a head-to-head arrangement, 
specify Tumble for the Sides value.  

(Use Preferences from the Options menu to set the default value for this option.) 

• Image fit - Specifies whether to scale the image or trim the image to fit the image to the 
finished page size. Select from the following: Scale to page Proportionally resizes the image 
to fit on the finished page. Trim to page Trims, or crops the outside edges of the image to fit 
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on the finished page. (Use Preferences from the Options menu to set the default value for 
this option.)  

• A graphic representation of the printed page layout is displayed on the right side of the 
Layout page using the selected layout and sides values. Click Show back to display the back 
side of the paper. This button is active when duplex or tumble is selected for the Sides value. 

 
Setting preferences 
You can specify your preferences for what will be used as the default values for the Printing, 
Layout, and Schedule options that are available the Scan Print dialog box. 

Notes:  
• Changing your preferences in Infoprint Scan will also change the preferences in Infoprint 

Submit running on the same workstation. Conversely, if preferences are changed in Infoprint 
Submit, the preferences will also be changed in Infoprint Scan. 

• Keep in mind that when you create a print job for an Infoprint Scan document, certain print 
option values, based on preferences as they are set at the time the job is created, are saved 
in the job ticket. If you resubmit the job at a later time, and preferences have since been 
changed, the job will ignore the new preferences and use the values that are saved in the job 
ticket. The values for the following options are saved in the job ticket: Printer Type, Output 
appearance, Screen frequency, Layout, Sides, and Page Content. The RIP Options, and 
values for Stacker, Priority, and Complexity are saved for the printer that is specified in 
Printer Type.  

To set your preferences (default values) for printing, page layout, and schedules: 

1. With a scanned document open and displayed in the Infoprint Scan main window, click 
Options in the menu bar, and then click Preferences....  

 
2. Set your preferences for default values in the Preferences dialog box. This dialog box 

contains three tabbed pages. Go to each of the following for an explanation of the attributes 
that can be set for:  
• From the Print page, you can select the default values for Print options.  
• From the Layout page, you can select the default values for Layout options.  
• From the Schedule page, you can specify the default values for Schedule options. 

The available options will change, depending upon which tab is selected. 

3. When you have finished setting your preferences, click the OK button. 
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Setting Print Preferences 
Click the Print tab in the Preferences dialog box to set these defaults:  

 
• Printer type - Select your preference for the type of printer used by default to print your 

documents. 
• Stacker - Select your preference for which output stacker on the printer is used by default for 

printed output. 
• Paper - Select your preference for the default for the size of paper to use when printing. 
• Screen frequency - Select your preference for the screen frequency used to print your 

documents. This specifies the screen name to use for the screen frequency value, or 
resolution of the halftone screen that is used for halftoning PostScript or TIFF grayscale data.  

• Output appearance - Select your preference for the output appearance (or style) of your 
printed documents. This is used to determine the dark and light levels when halftoning 
PostScript or TIFF grayscale data. Selecting Highlight midtones results in more contrast in 
the middle tones, less for the most dark and most light. Selecting Dark makes halftones print 
darker overall. 

• Bits per spot - Select your preference for the number of bits used to describe the gray value 
for each pixel. A value of 2 allows four levels of gray, from 0 to maximum density; a value of 4 
allows sixteen levels. 

• Quark SetTrap - Select Yes if you prefer to enable trapping for Quark Xpress jobs or No if 
you prefer to disable trapping. 

• Black Overprint - Select Yes if you prefer to print black over colors, or No if you prefer to 
omit colors from areas where black will be printed. 
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Setting Layout Preferences 
Click the Layout tab in the Preferences dialog box to set these defaults:  

 
• Layout - Select your preference for the default output format (or page layout) used to print 

your Infoprint Scan documents. 
• Sides - Select your preference the default for how documents will be printed on the paper:  

− Use server default - use the Infoprint server's default setting.  
− Simplex - print on one side of the paper.  
− Duplex - print on both sides of the paper.  
− Tumble - prints on both sides of the paper so that the top of one side of the sheet is at 

the same end as the bottom of the other side. Sometimes referred to as "head-to-foot" 
printing.  

• Image Fit group box - Select your preference for whether to trim or to scale the image to fit 
the finished page. Select from the following:  
− Trim to finished page size - trims, or crops the outside edges of the image to fit on the 

finished page.  
− Scale to finished page size - proportionally resizes the image to fit on the finished page. 

• Units - Select your preference between millimeters and inches for the default Units value.  
• Decimal Notation - Select your preference for the character used as a decimal delimiter.  
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Setting Schedule Preferences 
Click the Schedule tab in the Preferences dialog box to set these defaults: 

 
• RIP Options - Select your preference for the default RIP option from the following: 

− Use server default - uses the Infoprint server's default setting.  
− Hold - holds the job at the server until you release it for printing.  
− Rip Only - RIPs the data without printing or holding the job. Error messages are sent 

from the server to the Message window only if you specify a Retain value; otherwise, no 
messages are returned from the server.  

− Rip then hold - RIPs the data and holds the job at the server until you release it for 
printing.  

− Print -RIPs the data (if needed) and prints the job.  
• RIP without waiting - select (check) this box to RIP the data whether all resources that the 

job requires, such as fonts and media, are ready on the printer or not. Deselect this box to 
hold the job without RIPping if any required resources are not ready. 

• Retain job at server - select your preference for retention of the job on the server after 
printing. Select from the following:  
− Do not retain - specifies that the print job not be retained at the server. Job status 

messages are not returned to the Job Message window when you select this option.  
− For __ Hours or Days - type a number in this field (when For is selected). This value 

combined with the units (select Hours or Days) specifies the amount of time to retain the 
job at the server.  

Note: Storing documents on the server takes up space on the hard drive and should be 
done conservatively and only temporarily. 

• General - Select your preferences for default values for the following:  
− Priority - Determines the order of importance for printing the document. Type or select a 

number to specify the priority of the job. Valid values are numbers from 1 to 10 (10 is the 
highest priority).  

− Complexity - Type or select a number to specify the complexity of a job. Valid values are 
numbers between 1 and 10 (10 is the most complex).. The makeup of a job determines 
its complexity. For example, a large document that contains many halftone images is 
more complex than a short, text-only document.  

When you have finished setting the default values to be used for Print, Layout, and Schedule, 
click the OK button to save your settings. 
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Refreshing printing options 
Use Refresh to update your options for printing, scheduling, and page layout, to be sure that the 
most current settings are used for default values.  

To refresh your printing, scheduling, and page layout options: 

• Click Options in the menu bar, then click Refresh. 

 

 
Checking print job status 
You can check the status of a job that has been submitted to the Infoprint server for printing. After 
you have submitted a job: 

1. Click Options in the menu bar, then click Print Job Status. 

2. In the Job Status dialog box, you can view the job ticket, view the job messages returned 
from the server, delete a job from the status list, or cancel the print job. You can also refresh 
the status list. For more details, go to Job Status. 

 
• View information about the print job in the display area.  

Go to "Display Area" on page 52 for information. 
• Perform actions using the command buttons.  

Go to "Command Buttons" on page 52 for information. 

3. Click the Close button to close the Job Status dialog box. 

Note: Job status is available while this Infoprint Scan session is open, for jobs submitted during 
this session. If you close and reopen the Scan session, the job status dialog box is 
cleared. 
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Display Area 
• Job status dialog box - Displays the name of the job ticket that was submitted, the customer 

name, the status, and the copies to print value. Job states reported here include:  
− Canceled  
− Completed (reported for any jobs that are no longer at server)  
− Held at server  
− Imposing at server  
− Interrupted at server  
− Paused at server  
− Pending at server  
− Preprocessing at server  
− Printing at server  
− Processing at server  
− Ripping at server  
− Saved at server (retained at server)  
− Sending  
− Terminating  
− Timed-out at server  

Tip: You can change the width of a column by dragging the edge of the column heading to the 
right or left. To make the column wide enough to display all current entries, double-click on 
the right edge of the column heading. 

Command Buttons 
• View Ticket... - click to open the Job Ticket window to view the formatted job ticket for the 

selected job.  
• Messages... - click to open the Job Messages window to view job status messages returned 

from the server for the selected job.  
• Delete - click to delete the selected job from the job status list.  
• Cancel Job - click to cancel the selected job. 

Note: Only active jobs can be canceled; jobs whose status are Completed cannot be 
canceled. 

• Refresh - click to query the status again and refresh the list to display current status of jobs 
and status of any newly submitted jobs. 
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Export an Infoprint Scan document as a PDF file 
You can use Infoprint Scan's Export function to save an entire Infoprint Scan document, including 
the job ticket and all associated TIFF files, as a single PDF file that can be viewed online or 
printed.)  

Note: You can also create a PDF file in Infoprint Scan using the Send to Acrobat menu item.  
For more information, see “Using Send to Acrobat” on page 131. 

To export an Infoprint Scan document as a PDF file: 

1. With a scanned document open and displayed in the Infoprint Scan main window, click 
File in the menu bar, and then click Export....  

 
2. In the Export pages to one file dialog box:  

 
• The Document radio button is selected, and the Current Page and Pages radio 

buttons are grayed out.  

© Copyright IBM Corp. 1999, 2001        53 



• The name and where the file will be saved is displayed to the right of the Browse... 
button. To change this name and/or location, click Browse....  
a. In the Open dialog box, specify a new name and/or location for the file. 
b. In the List Files of Type field, select PDF (*.pdf). 
c. Click Open to return to the Export Pages to One File dialog box.  

 

3. In the Export pages to one file dialog box: 
• Select (check) the Make whites transparent check box if you want all of the “white“ 

areas, or “white” pixels, in the PDF file to really be transparent. 
• Deselect (uncheck) the Make whites transparent check box if you want all of the 

white areas, or white pixels, in the PDF file to actually be opaque white. 
4. In the field in the lower left, select the PDF file format. 
5. The field in the lower center displays the color format. The only valid choice is Binary.  
6. The field in the lower right displays the compression type. Select G4. 
7. Click OK to save the file. 
8. Now you can:  

• Store the PDF file  
• Send the PDF file to someone else  
• Launch Adobe Acrobat Reader to view and print the PDF file  
• Launch the IBM Infoprint 2000 Print File Downloader to print the PDF file on an 

Infoprint 2000  
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PDF files 
PDF (Portable Document Format) is the file format used by Adobe Acrobat. PDF files contain a 
very compact representation of text and graphics that enables documents with complete text and 
graphics to be viewed and printed on DOS, Macintosh, Windows, and UNIX (AIX, SGI, SUN, 
Solaris, and Linux) systems. 

Benefits of exporting a Scan document as a PDF file  
• A PDF file comes in handy if you need to send a final copy of a scanned document to another 

location. For example, if a scanned document is not exported as a PDF file, the job ticket for 
a 100-page scanned document will include 100 individual TIFF files that you have to keep 
track of and send. An exported PDF is a single file that contains the job ticket and all 
associated TIFF files.  

• The PDF file can be viewed online and printed using the Adobe Acrobat Reader, or you can 
use the functions of the Infoprint 2000 Print File Downloader to print the PDF file on an 
Infoprint 2000.  

• The following information may be of assistance when you are deciding whether to use local 
printing or to export a scanned document as a PDF file:  
− Some local print drivers impose restrictions that can be avoided if you print a PDF file. For 

example, the Infoprint 2000 PCL driver has a 1/4-inch restriction on printing to the edge 
of a sheet of paper. If this is a problem for a particular job, export and print the job ticket 
as a PDF file. 

− A PDF file is more efficient with space and performance than PCL when you print large 
Scan jobs (over 100 pages). PCL does not use image compression. Since PDF images 
are compressed, they use less space on your system, and transfer time is shorter. 

− For less demanding jobs, local PCL printing uses a simpler workflow. Though the workflow 
includes additional steps for export, you'll do better with PDF files for larger, more 
complex jobs. 
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Zoning pages in an Infoprint Scan document 
You can use the manual zoning functions to rescan a selected part of a page at different scanner 
settings than the rest of the page. For example, on a page that contains a combination of text and 
a halftone, you can specify a zone for the halftone and increase the contrast or sharpness of the 
halftone image within the zone. 

When a zoned area is rescanned, the result is a rectangular area called a layer. After you have 
created such layers, you can find additional information about working with the layers in 
"Modifying layers with Infoprint Scan" on page 95. 

Note: The zoning function options will only be available in the Page menu when your workstation 
is attached to a scanner that supports manual zoning. 

The following procedures are described: 
• "Zoning a page" on page 57 
• "Selecting scanner settings for zoned areas" on page 59 
• "Viewing or modifying settings for a defined zone" on page 60 

 
Zoning a page 
To zone a page of an Infoprint Scan document you must have the document open to the page 
that you want to zone.  

Note: A page must first be scanned without zoning before you can zone the page. 

Once a page has been scanned, you can: 
• Zone and rescan a page while a new document is still open immediately after scanning. 
• Open a previously scanned document to zone and rescan a page.  
• Open a previously scanned document and append a new page that you will then zone and 

rescan.  

To zone a page: 
1. Go to the page that you want to zone.  For information about going to a particular page, see 

"Navigating through an Infoprint Scan document" on page 121. 

2. Place the hardcopy page on the scanner, exactly as it was placed when it was originally 
scanned. 

3. To define a zone, click Page in the menu bar, and then click Add Zone.  
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A cross hair cursor will be displayed. 

 

4. Position the cursor and hold down the left mouse button as you move the cursor to define a 
rectangular zone. When the rectangle encloses the zone, release the left mouse button.  

 
The Zone Scan Settings dialog box will open. 

Note: Once you release the left mouse button, you will not be able to adjust the size of the 
rectangle. To change the size of a zone, you need to delete the zone: 
a. Click Page in the menu bar, and then click Remove Zone. 
b. Begin again with step 1 on page 57. 

5. In the Zone Scan Settings dialog box, click the Change Settings button to specify the 
scanner settings for this zone.  
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The Mode, Resolution, and Original Size fields cannot be edited in the Zone Scan Settings 
dialog box. These fields reflect the options you select for scanner settings.  

 
For more information, see "Selecting scanner settings for zoned areas" on page 59. 

6. When you have finished defining the settings for the current zone, click Rescan in the Zone 
Scan Settings dialog box. 

7. When the zone has been rescanned, if you want to define one or more additional zones, click 
OK.  Use the zoning tool again to define another zone and repeat steps 1 through 6 for each 
additional zone. 

8. When you have finished defining and rescanning all zones, click OK to return to the open 
document and save your zone settings for the current session only. 
(Click Cancel to return to the open document without saving your settings.) 

9. When you have finished with the document: 
• Click File in the menu bar, and then click Close to close and save the open document. 

or  
• Click File in the menu bar, and then click Exit to close and save the open document and 

exit the Infoprint Scan program. 

Note: When you rescan a zone, be sure to use: 
− the Rescan button in the Zone Scan Settings dialog box  

or 
− the Rescan… option in the Page menu. 
Do not use the Scan option in the File menu to rescan a zoned page, because the 
zone(s) will not be recognized and you will rescan the page using the same settings 
across the entire page. 

 
Selecting scanner settings for zoned areas 
Every scanner is different and has its own settings that control how pages will be scanned. 
Infoprint Scan supports the industry standard ISIS scanner drivers that are provided by the 
scanner manufacturers. These drivers provide default scanner settings based on standard types 
of hardcopy originals. You can use the default settings or you can modify the settings as 
necessary to get the best quality output. 

To view or modify scanner settings: 
1. Click the Change Settings button in the Zone Scan Settings dialog box. 
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2. In the Scanner Settings dialog box:  
a. Modify the settings as appropriate, or use the default settings. 
b. To view or modify additional, advanced settings, click the More... button.  
c. Modify the advanced settings as appropriate, or use the default settings, then click the 

OK button. 
d. When you are done, click the OK button in the Scanner Settings dialog box.  

If you need assistance understanding and using the available scanner settings:  

• For an explanation of the settings that can be specified for the Fujitsu M4097D scanner, refer 
to “Fujitsu M4097D scanner settings” on page 19. 

• For information about the settings that can be specified for any other scanner, refer to the 
documentation provided by the manufacturer of your scanner.  

 
Viewing or modifying settings for a defined zone 
After you close a document containing a page or pages that you have zoned, the zone settings 
are saved for the current Infoprint Scan session only. You can close and then reopen a document 
to further modify the zone settings for a page or pages, as long as you have not exited Infoprint 
Scan since defining the zones. The original settings for zones are restored at the start of every 
Infoprint Scan session. 

To view or modify the settings for previously defined zones: 

1. Open the Scan document that contains the defined zone(s). 

2. Go to the page that contains the zone(s) you want to view or modify.  For information about 
going to a particular page, see "Navigating through an Infoprint Scan document" on page 
121. 

3. Place the corresponding hardcopy page on the scanner, exactly as it was placed when it was 
originally scanned. 

4. To open the Zone Scan Settings dialog box, click on to select the defined zone, then click 
Page in the menu bar, and then click Zone Settings.  

 
Notes: 
• When a zone is selected, it displays with a broken outline. 
• Double clicking on the defined zone will also open the Zone Scan Settings dialog box 

for that zone. 

5. In the Zone Scan Settings dialog box, click the Change Settings button to view or modify the 
scanner settings for the selected zone.  
The Mode, Resolution, and Original Size fields cannot be edited in the Zone Scan Settings 
dialog box. These fields reflect the options you select for scanner settings.  
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For information about setting the scanner, see "Selecting scanner settings for zoned areas" 
on page 59. 

 
6. If the area to be rescanned contains a combination of text and graphic images, or just images 

with no text, be sure to select (check) the Use Text and Image Mode check box. 

7. When you have finished viewing or modifying the settings for the selected zone, to rescan the 
zone with the new settings, click Rescan in the Zone Scan Settings dialog box. 

8. When the zone has been rescanned, if you want to view or modify the settings for one or 
more additional zones, click OK and repeat steps 2 through 6 for each additional zone.  

8. When you have finished viewing, modifying, and rescanning the defined zones:  
• Click File in the menu bar, and then click Close to close and save the open document. 

or  
• Click File in the menu bar, and then click Exit to close and save the open document and 

exit the Infoprint Scan program. 

Note: When you rescan a zone, be sure to use: 
− the Rescan button in the Zone Scan Settings dialog box  

or 
− the Rescan… option in the Page menu. 
Do not use the Scan option in the File menu to rescan a zoned page, because the 
zone(s) will not be recognized and you will rescan the page using the same settings 
across the entire page. 
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Aligning pages in an Infoprint Scan document 
When you scan a document, each page may not come out perfectly centered and aligned with 
the pages that precede and follow it. This can be particularly obvious when you scan and then 
print a duplex document. You can use the Page Alignment function to align pages on a common 
reference point, such as a page number.  

The following page alignment tools are provided in the tool bar: 

 Move page - moves the page in relation to the cross hairs. 

 Undo alignment - undoes all of the alignment actions performed on the current page only. If 
you have made changes to more than one page, you must undo changes made to each 
page individually. 

 Set reference - provides a cursor used to display or move cross hairs.  

Tip: To deselect the Set Reference or Move Page tool, click the Deselect Tool button . 

The following tools that may be used with page alignment are also provided in the tool bar:  

 Copy changes - copies the alignment reference point for the current page, as well as other 
page editing changes, to another page or pages. 
(See "Copy changes vs Copy button" on page 119 for related information.) 

 Save changes - saves the page alignment and any other editing (such as, add text, erase, 
cut, copy, paste) done to all pages in the document. 

 
Aligning pages 
To align the pages in an Infoprint Scan document: 

1. Create a new document (see page 7 for information) or open a previously saved scanned 
document. 

2. Make the page you want to use for alignment the current page.  For information about going 
to a particular page, see "Navigating through an Infoprint Scan document" on page 121. 

3. Note: For best results, maximize the display window when using Page Alignment.  If 
necessary, use the Zoom button on the tool bar to zoom in so you will have a closer view of 
the area you are working on. (See "Zooming" on page 123 for information.) 

4. To set the alignment for the currently displayed page:  

a. Click the Set Reference button . 
A cross hair cursor will be displayed. 
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b. Hold down the left mouse button to move the cursor to position the cross hairs where you 
want them on the page. The placement of the cross hairs will determine the position of 
the reference point on which to align the page. 

 

c. When the cross hairs are positioned, release the left mouse button. 
d. Click and hold down the left mouse button again to move the cursor and position a 

second set of cross in the opposite corner of the page. 
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e. Click the Move page button  and hold down the left mouse button to move the page 
in relation to the cross hairs.  
or 
You can also move the page in relation to the cross hairs by using the arrow keys on your 
keyboard, allowing more precise positioning. 

 
If you're using the Move Page tool, when the page is in the correct position for alignment, 
release the left mouse button. 

5. To set the alignment for additional pages, use either of the following methods:  
a. To set the alignment for other pages individually, repeat step 4 for each page needing 

alignment.  
or 

b. To copy and use exactly the same changes made on the current page to another page or 

pages, click the Copy changes button . 
(Do not confuse the Copy changes button with the Copy button, as they are very similar. 
See "Copy changes vs Copy button" on page 119 for additional information.) 

6. Click the Save changes button  in the tool bar to save your alignment settings. 

7. Click Yes in the message box when prompted. 

 
8. When you are finished using the Page Alignment function, click View in the menu bar, and 

then click Display Reference Mark to turn off the cross hairs. 
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9. When you have finished with the open document: 
a. Click File in the menu bar, and then click Close to close and save the open document. 

or 
b. Click File in the menu bar, and then click Exit to close and save the document and exit 

the Infoprint Scan program. 
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Erasing areas from pages in an Infoprint Scan document 
You can use the Infoprint Scan Erase function to define and delete a rectangular area from a 
page or pages. 

To erase areas from pages in an Infoprint Scan document: 

1. Create a new document (see page 7 for information) or open a previously saved scanned 
document. 

2. Go to the page that contains the area you want to erase.  For information about going to a 
particular page, see "Navigating through an Infoprint Scan document" on page 121. 

Note: For best results, maximize the display window.  If necessary, use the Zoom button on 
the tool bar to zoom in so you will have a closer view of the area you are working on. 
(See "Zooming" on page 123 for information.)  Always zoom before you define the 
rectangular area with the cursor. 

3. Click the Selection Tool  button in the tool bar. 

4. Click Tools in the menu bar, and then click Erase Region. 

 
A cross-hair cursor will be displayed. 

5. Position the cursor and hold down the left mouse button as you move the cursor to define a 
rectangular area containing the part of the image you want to erase. 
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6. When the unwanted data is no longer visible, release the left mouse button. 

 
7. Repeat steps 3 through 6 for each area on the page that needs to be erased. 

Tip: To deselect the eraser, click the Deselect Tool button  in the toolbar. 

8. After you have defined a rectangular area to erase, and before you save your changes, you 
can change the position of the erasing rectangle. Position the pointer over the rectangle and 
hold down the left mouse button as you move the rectangle to its new location. 

 
9. When the rectangle is in its new position, release the left mouse button. 
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10. To erase areas on additional pages, use either of the following methods: 

a. To erase areas on other pages individually, repeat steps 1 through 4 for each page that 
needs erasures. 
or  

b. To copy and use exactly the same erasure done on the current page to another page or 

pages, click the Copy changes  button. 

(Do not confuse the Copy changes button with the Copy button, as they are very similar. 
See "Copy changes vs Copy button" on page 119 for additional information.) 

Note: You can undo erasures before you save your changes: 
• Click Tools in the menu bar, and then click Undo Erase to undo a selected 

or the last erasure done on the current page (you can do this multiple times). 

 
or  

• Click the Deselect Tool  button, select a deleted area, then click Tools 
in the menu bar, and then click Undo Erase. (When an area is selected, it 
has a broken outline.) 

After you have saved changes, none of your erasures can be undone. 

11. Click the Save changes button  to save your changes. 

12. Click Yes in the message box when prompted. 

 
13. When you have finished with the open document: 

• Click File in the menu bar, and then click Close to close and save the open document. 
or  

• Click File in the menu bar, and then click Exit to close and save the document and exit 
the Infoprint Scan program. 

© Copyright IBM Corp. 1999, 2001        69 



70   Using IBM Infoprint Scan  



 

 

Adding text and page numbers to pages in an Infoprint 
Scan document 
You can add, edit, format, move, and copy text to pages in an Infoprint Scan document. You can 
also add single or consecutive page numbers. 

Note: You cannot add text to a page that has been scanned as grayscale.  If you need to place 
text and one or more grayscale images together on the same page, see “Placing text and 
grayscale images on the same page” on page 128. 

 
Adding text 
To add text to a page in an Infoprint Scan document that was scanned as black and white: 

1. Go to the page where you want to add the text.  For information about going to a particular 
page, see "Navigating through an Infoprint Scan document" on page 121. 

2. Click the Selection Tool  button in the tool bar. 

3. Click Tools in the menu bar, and then click Add Text....  

 
A cross hair cursor will be displayed. 

4. Position the cursor and hold down the left mouse button as you move the cursor to define a 
rectangular area where you want to enter text. When the box is the right size and shape, 
release the left mouse button.  

 

© Copyright IBM Corp. 1999, 2001        71 



Note: Once you have released the left mouse button, you cannot resize the text box. If you 
size the box incorrectly, you will have to delete the box and begin again. 
(See "Removing text" on page 74 for information about deleting text boxes.)  

5. In the Adding Text dialog box, select the text alignment: L (left), C (center), or R (right).  

 
6. Click the Font button to select the font settings for the text you want to add.  

 
7. When you have finished selecting the font settings, click the OK button to return to the 

Adding Text dialog box. 
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8. Enter the text in the space provided.  

 
Tip: To find out how to add page numbers here, go to "Adding page numbers" on page 75. 

9. Click the Apply button. 

The text appears at the top of the text box that you defined earlier.  

 

10. When you have finished entering the text, click the OK button. 

11. After you have added a text box, and before you save your changes, you can change the 
position of the text box. Position the pointer over the text box and hold down the left mouse 
button as you move the box to its new location.  
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12. When the text box is in its new position, release the left mouse button. 

13. To add text to additional pages, use either of the following methods:  
a. To add text to other pages individually, repeat steps 1 through 9 for each page where you 

want to add text. 
or 

b. To copy and use exactly the same text added to the current page to another page or 

pages, click the Copy changes button . 
(Do not confuse the Copy changes button with the Copy button, as they are very similar. 
See "Copy changes vs Copy button" on page 119 for additional information.) 

Removing text 
You can remove added text before you save your changes: 
• Click Tools in the menu bar, and then click Undo Text to remove the last text added to the 

current page (you can do this multiple times). 

 
or  

• Click the Deselect Tool button , select a text box, then click Tools in the menu bar, and 
then click Undo Text. (When a text box is selected, it has a broken outline.) 

Editing text 
You can also edit the text in a text box before you save your changes: 
1. Position the pointer over the text box you want to edit. 
2. Double-click the left mouse button. 
3. Repeat any of steps 5 through 9 (beginning on page 72) that are necessary.  Each time you 

click the Apply button, your changes appear in the defined text box. 
a. When you have finished editing the text, click the OK button to return to the open 

document. 

b. When you have finished adding and editing the text, click the Save changes button  
in the tool bar to save the text. 

Note: After you have saved changes, the added text cannot be edited or undone. 
c.  Click Yes in the message box when prompted.. 
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d. When you have finished with the open document: 
• Click File in the menu bar, and then click Close to close and save the open document. 

or 
• Click File in the menu bar, and then click Exit to close and save the document and exit 

the Infoprint Scan program.  

 
Adding page numbers 
To add a page number to a page in an Infoprint Scan document, follow the general instructions 
for "Adding text” on page 71, except: 
• After you've defined a text box in the size and position where you want to place the page 

number, enter the following string in the Adding Text dialog box to add a number that 
corresponds to the number of the current page:  

%%N0  
Don't forget to specify the font settings you want to use for the page number. 
The 0 (zero) specifies that you want to use the actual number of the current page. 

Example  
If you are on the first page of the document, and want to add the string Page 1 at a defined 
location on the page: 

1. Type the following in the Adding Text dialog box:  
Page %%N0 
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2. Click the Apply button to see "Page 1" appear in the defined text box. 

 

• The number at the end of the string specifies that you want to start numbering with the 
number of the current page plus or minus the number you enter.  
− For example, if your document has some front matter and/or blank pages at the 

beginning, and you want the 5th page to start numbering as Page 1, make the 5th page 
the current page and type the following in the Adding Text dialog box:  

Page %%N-4 

− For another example, if you're on the first page of a document, but want the numbering 
on that page to start at 4, type the following in the Adding Text dialog box:  

%%N3 or %%N+3  

• To add consecutive numbers to additional pages, click the Copy changes button  to open 
the Copy Page Changes dialog box. Here you can specify to copy the text box with your page 
numbering notation to the entire document, to odd or even pages, or to a list or range of 
pages in the document.  

Important: If you have added page numbering (or any other changes) you will be prompted to 
save the changes to the document before you can continue with additional 
scanning. Therefore, be sure that you have scanned all pages and verified the order 
of pages in a document before you add, copy, and save page numbering. Once 
page numbering has been saved, the numbering will not be updated if you insert 
additional pages. 

76   Using IBM Infoprint Scan  



 

 

Resizing page images in an Infoprint Scan document 

With Infoprint Scan, you can resize the image of a page, selected pages, or all of the pages in a 
scanned document. 

Notes: 
• You cannot resize a page image that was scanned as grayscale. 
• Page images are resized proportionally, preserving the aspect ratio of the image, as shown in 

Figure 4. 
• Resizing the page image with Infoprint Scan will permanently change the image.  After 

resizing, you will not be able to return the image to its original size. 
• You can resize the entire page image only.  This version of Infoprint Scan does not support 

the resizing of a selected portion of a page (such as the image of a drawing or photograph 
that is a part of a page that includes mixed text and graphics). 

     
Figure 4.  Scaling the page image proportionally, preserving the aspect ratio 

To resize a page image: 

1. Create a new document (see page 7 for information) or open a previously saved scanned 
document. 

2. Go to the page you want to resize.  For information about going to a particular page, see 
"Navigating through an Infoprint Scan document" on page 121. 
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3. Click Edit in the menu bar, and then click Resize Image... 

 
4. In the Resize Images dialog box: 

a. Select the appropriate radio button to specify that you want to resize just the currently 
displayed image (page), a range of pages, or every page of the document.  
When you select Range of Pages, the Range field will become available, where you can 
enter which pages you want to resize. Here you can type: 
• the number of each page, separated by a comma (for example: 2,10,26,40) 

or 
• the beginning and end of a range of pages, separated by a hyphen  

(for example: 13-15) 
or 

• a combination of both (for example: 1-4,10,15,18-23). 

Note: Do not include spaces after the commas. 

 

b. You can scale the page image(s) by specifying a percentage, or by specifying a fixed 
width or height. 
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• To resize the page image by specifying a percentage: 
− Click (select) the Percent Size radio button. 
− Type a number in the % field. 

Infoprint Scan will adjust the width and height of the page image by the percent 
you specify.  This adjustment is immediately reflected in the Output Size fields. 

− Click the OK button. 

 
• When you know the finished size that you want for one of the page dimensions, you 

can let Infoprint Scan figure the correct size for the other. 

For example, for a finished page width of five inches: 
− Click (select) the Dimensions radio button. 
− Type 5 in the Width field. 

Infoprint Scan will automatically adjust the dimension in the Height field in 
proportion to the new width. 

− Click the OK button. 
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For a finished page height of seven inches:  
− Click (select) the Dimensions radio button. 
− Type 7 in the Height field. 

Infoprint Scan will automatically adjust the dimension in the Width field in 
proportion to the new height. 

− Click the OK button. 

 

5. Click the OK button to resize. 

Remember! 
Resizing will permanently change the image.  You cannot undo the resizing of a page 
image. 

6. When you have finished resizing, and are finished with the open document: 
• Click File in the menu bar, and then click Close to close and save the open document. 

or 

Click File in the menu bar, and then click Exit to close and save the document and exit the 
Infoprint Scan program.  
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Trimming and cropping page images 
Infoprint Scan provides two similar functions: 
• Use the Edge Erase function to trim a defined area along any or all of the outside edges of a 

page or pages.  See “Erase edges” for information. 
• Use the Crop function to eliminate unwanted areas of an image by cutting off one or more of 

the image edges.  See “Crop an image” on page 82 for information. 

 
Erase edges 
To erase the edges of a page: 

1. Click Edit in the menu bar and then click Edge Erase.... 

 
2. In the Specify trim amount dialog box, select the appropriate radio button to specify that you 

want to erase an edge or edges on just the currently displayed image (page), specified 
pages, or every page of the document. 
When you select Range of Pages, the Range field will become available, where you can 
enter which pages you want to have cropped.  Here you can type the number of each page, 
separated by a comma (for example: 2,10,26,40), or the beginning and end of a range of 
pages, separated by a hyphen (for example: 13-15), or a combination of both (for example: 1-
4,10,15,18-23).  Do not include spaces after the commas. 

 
3. In the Top and Bottom fields, specify the height of the area you want to trim.  For example, to 

remove nothing from the top edge and 3/4 inch  from the bottom edge of the page, type: 
• 0.00 in the Top field. 
• 0.75 in the Bottom field. 
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4. In the Left and Right fields, specify the width of the area you want to trim.  For example, to 
remove 1/2 inch from the left edge and nothing from the right edge of the page, type: 
• 0.50 in the Left field 
• 0.00 in the Right field 

5. Click OK to erase the edges. 

 
Crop an image 
To crop an image: 

1. Click Edit in the menu bar and then click Crop…. 

 
2. In the Crop image dialog box, select the appropriate radio button to specify that you want to 

crop just the currently displayed image (page), specified pages, or every page of the 
document. 

When you select Range of Pages, the Range field will become available, where you can 
enter which pages you want to crop.  Here you can type the number of each page, separated 
by a comma (for example: 2,10,26,40), or the beginning and end of a range of pages, 
separated by a hyphen (for example: 13-15), or a combination of both (for example: 1-
4,10,15,18-23).  Do not include spaces after the commas. 

3. To crop from the top and left edges of the image: 
In the Top and Left fields, specify the number of inches you want to remove.  For example, to 
remove one inch from the top and one-half inch from the left edge of an image, specify: 
• 1 in the Top field 
• 0.5 in the Left field 
• Leave the Right and Bottom fields as they are. 

 
4. Click OK to crop the top and left edges of the image. 
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5. To crop the right and bottom edges of the image: 
In the Right and Bottom fields, specify the final width and height of the image.  For example, to 
remove one inch from the right and bottom of an image that is currently 8.5 inches wide by 11 
inches high, specify: 
• 0 in the Top field 
• 0 in the Left field 
• 7.5 in the Right field 
• 10 in the Bottom field 

 
6. Click OK to crop the right and bottom of the image. 
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Using Infoprint Scan cut, copy, and move functions 
These procedures describe how you can cut, copy, and move areas of a page in an Infoprint 
Scan document.  When a cut or copied area is pasted onto a page, the result is a rectangular 
area called a layer. After you have learned how to create these layers, you can find additional 
information about working with the layers in "Modifying layers with Infoprint Scan" on page 95. 

To cut, copy, and move areas of a page, you can use either of the following: 

• The options in the Edit menu: 

 
or 

• The tools in the tool bar: 

 Cut - deletes a specified area from the current page, and places it on the clipboard. 

 Copy - copies a specified area from the current page to the clipboard.  
(See "Copy changes vs Copy button" on page 119 for related information.)  

 Paste - places the contents of the clipboard at a specified location in the current 
Infoprint Scan document. 

Note: The clipboard is a buffer where a cut or copied page area is stored. You can paste 
the contents of the Infoprint Scan clipboard onto a page in an Infoprint Scan 
document. Infoprint Scan uses an internal clipboard, not the Windows clipboard. You 
cannot paste the contents of Infoprint Scan's internal clipboard into other 
applications, nor can you paste the contents of the Windows clipboard into an 
Infoprint Scan document. 

The following tools that may be used when you cut, copy, and move areas are also provided in 
the tool bar: 

 Copy changes - copies the editing done to areas on the current page to another page or 
pages. (See "Copy changes vs Copy button" on page 119 for related information.) 

 Save changes - saves the editing and other changes (such as, add text, zoning, or page 
alignment) done to all pages in the document. 
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Tips: 

• To deselect the Cut tool or the Copy tool, click the Deselect Tool button . 
• See "Navigating through an Infoprint Scan document" on page 121 for information about 

making a particular page the current page. 
• For best results, you may want to maximize the display window.  If necessary, use the Zoom 

button on the tool bar to zoom in so you will have a closer view of the area you are working 
on. (See "Zooming" on page 123 for information.) Always zoom before you define the 
rectangular area with the cursor. 

To cut, copy, and move areas on pages in an Infoprint Scan document, Infoprint Scan must be 
started and the document needing these editing operations must be open.   
To find out how to: 
• delete an area from a page, see "Cut" on page 86. 
• duplicate an area, see "Copy" on page 88. 
• move an area to a new position on the same page or on a different page, see "Move" on 

page 91. 

 
Cut 
To cut or delete an area of the currently displayed page:  

1. Click the Selection Tool  button in the tool bar.  
A cross hair cursor will be displayed. 

2. Click the Cut button  in the tool bar. 
or 
Click Edit in the menu bar, and then click Cut. 
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3. Position the cursor and hold down the left mouse button as you move the cursor to define a 
rectangular area containing the part of the image you want to delete. 

 

4. When the area is defined, release the left mouse button. 

 
5. To delete additional areas, use either of the following methods: 

a. To delete individual areas on the same page or on other pages, repeat steps 1 through 4 
for each area you want to delete. 
or 

b. To duplicate the same deleted area or areas from the current page on another page or 

pages, click the Copy changes  button.  
(Do not confuse the Copy changes button with the Copy button, as they are very similar. 
See "Copy changes vs Copy button" on page 119 for additional information.) 

Note: You can use the Undo Erase option in the Tools menu to undo deletions before you 
save your changes: 

• Click Tools in the menu bar, and then click the Undo Erase option to undo a 
selected or the last deletion done on the current page (you can do this multiple 
times). 
or 

• Click the Deselect Tool  button and select a deleted area.  Now click Tools 
in the menu bar, and then click the Undo Erase option.  (When an area is 
selected, it has a broken outline.) 

Remember! 
After you have saved changes, none of your cuts can be undone. 
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6. When you are finished deleting areas from pages in the document, click the Save changes 

button  to save the deletions and any other changes. 

7. Click Yes in the message box when prompted. 

 
8. When you have finished with the open document: 

• Click File in the menu bar, and then click Close to close and save the open document. 
or 

• Click File in the menu bar, and then click Exit to close and save the document and exit 
the Infoprint Scan program. 

 
Copy 
To copy or duplicate an area of the currently displayed page: 

1. Click the Selection Tool  button in the tool bar.  
A cross hair cursor will be displayed. 

2. Click the Copy button  in the tool bar. 
or 
Click Edit in the menu bar, and then click Copy. 
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3. Position the cursor and hold down the left mouse button as you move the cursor to define a 
rectangular area containing the part of the image you want to copy. When the area is defined, 
release the left mouse button. 

 

4. To place the copied area on the current page go directly to the next step. 
or 
If you are moving the copied area to a different page, go to that page.  For information about 
going to a particular page, see "Navigating through an Infoprint Scan document" on page 
121. 

5. Click the Paste button  in the tool bar.  
or 
Click Edit in the menu bar, and then click Paste. 

 
The copied area is pasted in the same position on the new page as it was on the original 
page. (If you have copied the area onto the same page, the copied area is duplicated on 
top of the original area.) Before you save your changes, you can still move the area to a 
different location on the page. 
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To reposition the area on the original page or on the page to which it was moved: 

a. Click the Deselect Tool button  and place the pointer over the duplicate area. 
b. Hold down the left mouse button, and drag the area to the new location. 
c. When the area is in the correct position, release the left mouse button. 

 

In this example, the defined area is copied to the same page and then dragged to a 
new location.  The area could also have been copied to any other  document. 

6. To duplicate the same copied area on additional pages, click the Copy changes button . 
(Do not confuse the Copy changes button with the Copy button, as they are very similar. 
See "Copy changes vs Copy button" on page 119 for additional information.) 

Note: To undo copied areas before you save your changes: 
• Click Edit in the menu bar, and then click Undo Layer to undo the last copy 

pasted onto the current page. 

 
or 

• Click the Deselect Tool button  and move the pointer to select a specific 
copied area, click Edit in the menu bar, and then click Undo Layer. (When an 
area is selected, it has a broken outline.) 
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Remember! 
After you have saved changes, you cannot undo any of your copies. 

7. When you are finished copying areas in the document, click the Save changes button  to 
save the copies and any other changes. 

8. Click Yes in the message box when prompted. 

 
9. When you have finished with the open document: 

• Click File in the menu bar, and then click Close to close and save the open document. 
or 

• Click File in the menu bar, and then click Exit to close and save the document and exit 
the Infoprint Scan program. 

 
Move 
To move an area of the currently displayed page to a new position on the same page or on a 
different page: 

1. Click the Selection Tool  button in the tool bar.  
A cross hair cursor will be displayed. 

2. Click the Cut button  in the tool bar. 
or 
Click Edit in the menu bar, and then click Cut.. 
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3. Position the cursor and hold down the left mouse button as you move the cursor to define a 
rectangular area containing the part of the image you want to move. 

 
4. When the area is defined, release the left mouse button. 

 
Note: You can use the Undo Erase option in the Tools menu to undo a cut before you paste 

it or save your changes: 
• Click Tools in the menu bar, and then click the Undo Erase option to undo the 

last cut done on the current page (you can do this multiple times).  
or 

• Click the Deselect Tool  button and select a deleted area.  Now click Tools in 
the menu bar, and then click the Undo Erase option.  (When an area is selected, 
it has a broken outline.) 

Remember!  After you have saved changes, none of your cuts can be undone. 

5. If you want to place the cut area on the current page go directly to the next step. 
or 
If you are moving the cut area to a different page, make that page the current page.  For 
information about going to a particular page, see "Navigating through an Infoprint Scan 
document" on page 121. 
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6. To place the area on the current page: 

• Click the Paste button  in the tool bar.  
or 

• Click Edit in the menu bar, and then click Paste. 

 
The area is pasted in the same position as it was on the original page. (If you are pasting on 
the same page, the area is in its same position on top of the original area.) 

7. To reposition the area on the original page or on the page to which it was moved: 

a. Click the Deselect Tool button  and position the pointer over the area. 

b. Hold down the left mouse button and drag the area to its new position. 

c. When the area is in the correct position, release the left mouse button. 

 

In this example, the defined area is pasted to the same page and then moved to a new 
location.  The area could also have been moved to any other page in the document. 
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Note: You can undo your pastes before you save your changes: 
• Click Edit in the menu bar, and then click the Undo Layer option to undo the last 

paste done on the current page (you can do this multiple times). 

 
or 

• Click the Deselect Tool  button and select a pasted area.  Now click Edit in 
the menu bar, and then click the Undo Layer option.  (When an area is selected, 
it has a broken outline.) 

Remember! 
After you have saved changes, you cannot undo any of your moves or other editing. 

8. When you are finished moving areas in the document, click the Save changes button  to 
save your moves and any other changes. 

9. Click Yes in the message box when prompted. 

 
10. When you have finished with the open document: 

• Click File in the menu bar, and then click Close to close and save the open document. 
or 

• Click File in the menu bar, and then click Exit to close and save the document and exit 
the Infoprint Scan program. 
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Modifying layers with Infoprint Scan 
A layer is a rectangular area of a page that is created when a cut or copied area is pasted onto 
the page from the Infoprint Scan clipboard or when a zoned area is rescanned. 

FYI: The Infoprint Scan clipboard is a buffer where a cut or copied page area is stored. You can 
paste the contents of the Infoprint Scan clipboard onto a page in an Infoprint Scan 
document. Infoprint Scan uses an internal clipboard, not the Windows clipboard. You 
cannot paste the contents of Infoprint Scan's internal clipboard into other applications, nor 
can you paste the contents of the Windows clipboard into an Infoprint Scan document. 

For information about creating layers by cutting, copying, pasting, and zoning areas of a page, 
refer to: 

• "Using Infoprint Scan cut, copy, and move functions" on page 85 
• "Zoning pages in an Infoprint Scan document" on page 57 

To modify a layer:  
1. Select the layer you want to modify.  

To select a layer, click the Deselect Tool button  in the tool bar, then position the pointer 
over the layer and click the left mouse button. When a layer is selected, it displays with a 
broken outline.  

 

Note: When a layer is selected, you can reposition it on the page, if necessary. To do so, 
place the pointer over the layer, hold down the left mouse button, and drag the area to 
the new position.  
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2. Click Edit, and then click one of the following:  

 
• Undo Layer - Select this option to undo a selected paste or rescanned zone or the last of 

these actions performed on the current page only. If you have pasted or rescanned 
zoned areas on more than one page, you must undo these actions on each page 
individually. 

• Toggle Transparency - Select this option once to eliminate the solid white background 
from the image in a layer so that only the black part of the image is displayed and printed. 
If the transparent layer is placed on top of another image or portion of an image on the 
page, that image will show through from behind the layer.  

 
Select the option again to include the solid white background with the image.  When the 
layer is placed on top of another image or portion of an image, that part of the other 
image will not show through from behind the layer. 

 
• Descreen Layer - Select this option to remove the halftone screen from a layer that 

contains an image that was scanned as grayscale. This function is only available if you 
have installed the Infoprint Scan Advanced features. 
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• Screen Layer - Select this option to apply a halftone screen to a layer that contains a 
continuous tone image or a grayscale image that has been descreened. This function is 
only available if you have installed the Infoprint Scan Advanced features. 

• Invert Layer - Select this option to reverse the black and white or grayscale image 
contained in a layer so that all blacks are white and all whites are black. On a "positive" 
image, the effect is similar to that of a photographic negative, as shown in Figure 5. 
Conversely, a negative image is made positive. 

 

 

 

Figure 5. The image in a defined area of the page is inverted. 

Note: This function works only on the image in a layer - if you want to reverse the 
image of the entire page, use the Invert Image option on the Enhance Images 
dialog box. For additional information, refer to page 32 of the "Enhancing images 
in an Infoprint Scan document" topic. 

• Histogram Stretch - This option adjusts the contrast on a selected layer to improve the 
appearance of a grayscale image. This function is only available if you have installed the 
Infoprint Scan Advanced features.  

FYI: A histogram looks at the range of tonal values in a grayscale image. The histogram 
calculates the tonal values from dark to light, and figures the distribution of the relative 
number of pixels at each level. These tonal values can be modified to change the level 
and distribution of dark and light areas of an image, adjusting and improving the 
relationship between the highlights, shadows, and midtones. If the histogram does not 
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cover the entire range from black to white, the image will not include both very dark or 
black and very light or white areas. You can use the Histogram Stretch function to 
expand (stretch) the distribution of tonal values in an image so that they cover the entire 
range from black to white. 

In the Histogram Stretch dialog box:  
a. Use the defaults, or modify these settings as required:  

• In the Percent Black field, type the percentage of the image that you estimate 
should be black. 

• In the Percent White field, type the percentage of the image that you estimate 
should be white. 

• If the image has a solid border around it, estimate the percentage of the image 
taken up by the border, and type that value in the Ignore Border field. The white 
or black pixels that make up the border will not be used when the percent of 
white or black is calculated. 

• In the Stretch Method field, select the method by which you want images to be 
modified. Unless you are familiar with the various methods available, use LStar, 
the default method, as it is appropriate for most images.  

 
b. Click the OK button.  

Tip: Unless you are very familiar with estimating and adjusting the percentages of 
black and white in an image, you should begin by using the defaults, and then 
make and compare additional adjustments in small increments until you achieve 
the desired results. 

• Rotate Layer - Select this option to change the orientation of a selected layer by any 
degree of rotation.  
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To rotate a layer: 
a. Select the layer you want to modify. 
b. Click Edit in the menu bar, then highlight Rotate Layer, slide right to the sub-menu and 

select one of the following options: 

 
− Exact Rotate... - opens a dialog box where you can specify any degree of rotation 

for the layer on the current page. 

 
− Rotate 90 - rotates the selected layer 90 degrees to the right. 
− Rotate 180 - rotates the selected layer 180 degrees to the right. 
− Rotate 270 - rotates the selected layer 270 degrees to the right. 
− Free Rotate - allows you to "grab" and rotate the layer with your mouse cursor and 

visually determine the degree of rotation. 
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3. When you are finished working with layers, click the Save changes button  in the tool bar 
to save your modifications and any other changes you have made to the Scan document.  

Note: Before you save your changes, be very sure that you have finished working with 
all layers and any other defined areas.  After you save changes to your Scan 
document, you will no longer be able to select or modify a layer, nor will you be able to 
perform any other actions on a changed area, such as rescanning a zone, 
repositioning a pasted area, or editing added text. 

4. Click Yes in the message box when prompted.  
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Adding and replacing pages in an Infoprint Scan 
document 
There are several ways that you can add new pages and replace existing pages in an Infoprint 
Scan document: 

• You can scan a new page or pages into the document. 
For information, go to "Scanning to add or replace pages" on page 101. 

• You can add one or more single-page TIFF (Tagged Image File Format) files to the 
document. 
For information, go to "Inserting TIFF files" on page 103. 

• You can add blank pages to the document. 
For information, go to "Inserting blank pages" on page 108. 

 
Scanning to add or replace pages 
To scan a new page or pages into an existing Infoprint Scan document: 

1. Open the Infoprint Scan document to which you want to add a page or pages. 

2. Place the hardcopy page or pages in the scanner's document feeder.   
• For the Fujitsu M4097D scanner, position the pages face down, inserting the sheets with 

the short edges leading.   
• For other scanners, refer to the manufacturer's instructions. 

3. Go to the location in the document where you want to insert the page or pages. 
See "Navigating through an Infoprint Scan document" on page 121 for assistance. 

This is not necessary if you are going to append the page or pages to the end of the 
document. 

4. Click File in the menu bar, and then click Scan.... 
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5. In the Original area of the Append Scan document dialog box, select: 

• One-sided - if the hardcopy is printed on just the front side of the paper. 
• Two-sided - if the hardcopy is printed on both the front and back sides of the paper. 

See "Scanning Two-Sided Originals" on page 119 for additional information about 
scanning two-sided originals. 

 
6. Click the Change Settings button to view or change the scanner settings.  

The Mode, Resolution, and Original Size fields cannot be edited in the Zone Scan Settings 
dialog box. These fields reflect the options you select for scanner settings. 

(Refer to "Setting up the scanner" on page 17 for information about scanner settings.) 

7. If your original hardcopy document contains a combination of text and graphic images, or just 
images with no text, be sure the Use Text and Image Mode check box is checked. 

8. If your original hardcopy document has a page size that is not listed among the scanner 
settings options, check the Custom Page size check box and enter the dimensions in the 
fields provided. 

9. Check the Rotate 90 degrees clockwise after scanning check box, only if you want to 
change the orientation after the document has been scanned. 

10. In the Location area, select one of the following: 

• Append to end of current document - to add the scanned page(s) at the end of the 
document that is currently displayed. The last added page will become the last page of 
the document. 

• Insert before current page - to add the scanned page(s) in front of the page that is 
currently displayed. 

• Insert after current page - to add the scanned page(s) in back of the page that is 
currently displayed. 

• Replace current page - to insert the scanned page(s) at the same location in the 
document as the page that is currently displayed, and delete the current page. For 
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multiple pages, the first scanned page will replace the current page and any subsequent 
pages will then be added behind it. 

Note: When you use the Insert before current page, Insert after current page, and 
Replace current page options, keep in mind that when you insert a page, the new 
page becomes the current page. If you add additional pages, depending on which 
option you select, the next page scanned will be inserted before, after, or will replace 
the last page scanned. 

11. Click the Scan button. 

12. When scanning has completed, if you want to scan another page or pages to add to specified 
locations in the document, place your hardcopy page(s) on the scanner, and repeat these 
instructions, beginning with step 3. 

13. When you have finished scanning all of the pages you want to add at this time, click the 
Close button to return to the open document. 

14. When you have finished with the open document: 
• Click File in the menu bar, and then click Close to close and save the open document. 

or 
• Click File in the menu bar, and then click Exit to close and save the document and exit 

the Infoprint Scan program. 

 
Inserting TIFF files 
Use this procedure when you want to insert previously scanned files or TIFF files created with 
programs other than Infoprint Scan. You can add existing TIFF files selectively, or you can add all 
of the files contained in a particular directory. 

Note: If any of the files that you want to insert are read-only, keep in mind that you will not be 
able to use any Infoprint Scan functions that would result in a modification to the read-only files 
(such as, image enhancement, page alignment, adding text, or any other editing). If you need to 
use these functions on the files or on the Infoprint Scan document that will include the files, first 
change the files to read/write, or create and insert read/write copies of the original files. 

To insert one or more TIFF files into an Infoprint Scan document: 

1. Open the Infoprint Scan document into which the TIFF file(s) will be inserted. 

2. Go to the location in the document where you want to insert the file(s). 
See "Navigating through an Infoprint Scan document" on page 121 for assistance. 

3. Click Page in the menu bar, and then click Add.... 
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4. To add one or more files selectively: 

a. Click the Add File button in the File Selection area of the Add Page dialog box. 

 
b. In the Open TIFF Files dialog box, locate the appropriate directory and highlight the file(s) 

you want to insert.  
See "Selecting multiple files" on page 120 for information about selecting multiple files. 

c. Click the Open button. 
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The highlighted file(s) will be added to the list box in the Add Page dialog box. 
See "Using the Add Page list box" on page 120 for information about using the list box. 

 

© Copyright IBM Corp. 1999, 2001        105 



5. To add all of the files in a directory: 
a. Click the Add Directory button in the File Selection area of the Add Page dialog box. 

 
b. In the Open Directory to Add Files From dialog box, select the directory that contains the 

files you want to insert. 

c. Click the Open button. 

 
The files contained in the highlighted directory will be added to the list box in the Add 
Page dialog box. If necessary, you can reorder the files or selectively remove individual 
files from the list. 
See "Using the Add Page list box" on page 120 for information about using the list box. 
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6. In the Add Page dialog box, select one of the following: 
• Append to end of current document - to add the TIFF file(s) at the end of the 

document that is currently displayed. The last added file will become the last page of the 
document. Multiple files will be processed in the order in which they appear in the list box, 
that is, from the top down. 

• Insert before current page - to add the TIFF file(s) in front of the page that is currently 
displayed. Multiple files in the list box will be processed in reverse order, so that the files 
are added one in front of the other, from the bottom of the list to the top of the list. 

• Insert after current page - to add the TIFF file(s) in back of the page that is currently 
displayed. Multiple files will be processed in the order in which they appear in the list box, 
that is, from the top down. 

• Replace current page - to insert the TIFF file(s) at the same location in the document as 
the page that is currently displayed, and delete the current page. For multiple files, the 
first file in the list will replace the current page and any subsequent files in the list will 
then be inserted after the current page. 

 
Note: When you use the Insert before current page, Insert after current page, and 

Replace current page options, keep in mind that when you insert a page, the new 
page becomes the current page. If you add additional pages, depending on which 
option you select, the next page scanned will be inserted before, after, or will replace 
the last page scanned. 

7. When you have finished with the open document:  
• Click File in the menu bar, and then click Close to close and save the open document. 

or 
• Click File in the menu bar, and then click Exit to close and save the document and exit 

the Infoprint Scan program. 
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Inserting blank pages 
To insert a blank page or pages into an Infoprint Scan document: 

1. Open the Infoprint Scan document into which the blank page(s) will be inserted. 

2. Go to the location in the document where you want to insert the blank page(s). 
See "Navigating through an Infoprint Scan document" on page 121 for assistance. 

3. Click Page in the menu bar, and then click Add.... 

 
4. Click the Insert Blank button in the File Selection area of the Add Page dialog box. The 

name of a new file containing a blank page will be added to the list box in the Add Page 
dialog box. 

 
To add multiple blank pages, click the Insert Blank button again for each blank page you 
want to add. 
See "Using the Add Page list box" on page 120 for information about using the list box. 

5. In the Add Page dialog box, select one of the following: 
• Append to end of current document - to add the blank page(s) at the end of the 

document that is currently displayed. The last added page will become the last page of 
the document. 
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• Insert before current page - to add the blank page(s) in front of the page that is 
currently displayed. 

• Insert after current page - to add the blank page(s) in back of the page that is currently 
displayed. 

• Replace current page - to insert the blank page(s) at the same location in the document 
as the page that is currently displayed, and delete the current page. 

Note: When you use the Insert before current page, Insert after current page, and 
Replace current page options, keep in mind that when you insert a blank page, the 
new blank page becomes the current page. If you add additional pages, depending on 
which option you select, the next page added will be inserted before, after, or will 
replace the last page added.  

6. In the Add Page dialog box, click the Done button to add the blank pages and return to the 
open document. 

7. When you have finished with the open document: 
• Click File in the menu bar, and then click Close to close and save the open document. 

or 
• Click File in the menu bar, and then click Exit to close and save the document and exit 

the Infoprint Scan program. 
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Rotating contents of a page 
You can rotate, or shift the contents of a page by any number of degrees.   

Figure 6 shows an example of what happens when you rotate the contents of the page. 

  
Figure 6. Rotate page is used to shift the rotation of the page contents by specified number of 
degrees. 

Note: This function does not change the orientation of the page.  What is on the page is rotated, 
not the page itself.  The rotated page contents are not scaled to fit on the page.  For 
example, if you specify to rotate the contents of a page by 90 degrees, the result will be as 
shown in Figure 7.  If you actually want to change the page orientation, use one of the 
rotation options (“AutoRotate Portrait” or “Rotate”) described in “Selecting enhancement 
options” on page 30 or as described in step 10 of “Scan a new Infoprint Scan document” 
beginning on page 7. 

  
Figure 7. Result from shifting the rotation of the contents of a page by 90 degrees. 
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To rotate the contents of a page or pages: 

1. Click Page in the menu bar, and then click Rotate…. 

 
2. In the Exact Rotate dialog box, select one of the following: 

• Current Page - to rotate the page that is currently displayed. 
• Range of Pages - to rotate the pages in a defined range. 

When you select Range of Pages, the Range field will become available, where you can 
enter which pages you want to rotate.  Here you can type the number of each page, 
separated by a comma (for example: 2,10,26,40), or the beginning and end of a range of 
pages, separated by a hyphen (for example: 13-15), or a combination of both (for example: 
1-4,10,15,18-23).  Do not include spaces after the commas. 

• Document - to rotate every page of the document. 

 
3. In the Degrees field, type the number of degrees to rotate the page(s). 

• A positive number will rotate the page to the right (clockwise). 
• A negative number will rotate the page to the left (counter-clockwise). 

4. Click the OK button. 
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Removing or deleting Infoprint Scan documents and 
pages 
The following procedures explain how you can: 

• "Remove or delete Infoprint Scan documents" (see page 113) 

• "Remove or delete pages from Infoprint Scan documents" (see page 114)  

 
Remove or delete Infoprint Scan documents 
Note: This function is not available when Infoprint Scan is invoked from within the Infoprint 

Submit program. 

To remove or delete an entire Infoprint Scan document: 

1. Open the Infoprint Scan document that you want to delete. 

2. Click File in the menu bar, and then click Remove.... 

 
3. In the Delete/Remove Pages dialog box, select the Document radio button. 
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4. You can then select to Remove or to Delete the document. The difference between the two 
is as follows: 
• If you select Remove, the TIFF files that make up the document will be no longer be 

associated with the job ticket.  The job ticket and TIFF files will still be retained on your 
disk.  A document that has been Removed, can be restored, as described in “Backing up 
and restoring Infoprint Scan documents” on page 117. 

• If you select Delete, the job ticket for the document and all associated TIFF files will be 
totally deleted from your system.  A document that has been Deleted cannot be restored. 

To proceed, click: 
a. The Remove button to disassociate the TIFF files from the job ticket. 

or 
b. The Delete button to totally delete the document files. 

5. Click File in the menu bar, and then click Exit to close the Infoprint Scan program. 

 
Remove or delete pages from Infoprint Scan documents 
You can remove specified pages from an Infoprint Scan document using the Remove option in 
either the File menu or the Page menu. 

• When you use the Delete option in the Page menu, you can remove a single page from the 
document without deleting the associated TIFF file from your disk. 

To find out how to remove a single page in this manner, go to "Remove the current page" on 
page 114. 

• When you use the Remove option in the File menu, you can remove a single page, or specify 
a range of pages to be removed from the document. You can also specify whether to keep 
the associated TIFF file(s), or to delete the TIFF file(s) from your system. 

To find out how to remove a page or range of pages in this manner, go to "Remove or delete 
selected pages" on page 115. 

Remove the current page 

You can use the Delete option in the Page menu to remove the currently displayed page of a 
Scan document. 

Note: The page will be removed from the document, but the associated TIFF file will not be 
deleted from your system. 

To remove a page from a document: 

1. Open the Infoprint Scan document that contains the page or pages that you want to delete. 

2. Go to the page in the document that you want to delete. 
See "Navigating through an Infoprint Scan document" on page 121 for assistance. 
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3. Click Page in the menu bar, and then click Delete. 

 
4. When you are finished: 

• Click File in the menu bar, and then click Close to close and save the open document. 
or 

• Click Exit to close and save the document and exit the Infoprint Scan program. 

Remove or delete selected pages 

You can use the Remove option in the  to remove a single page or to specify a range of pages to 
be removed from the document. You can also specify whether to keep the associated TIFF file(s), 
or to delete the TIFF file(s) from your system. 

To remove or delete selected pages: 

1. Open the Infoprint Scan document that contains the page or pages that you want to remove 
or delete. 

2. Click File in the menu bar, and then click Remove.... 
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3. In the Delete/Remove Pages dialog box, select: 
• Current Page - to remove or delete the page that is currently displayed. 

or 
• Range From __ to __ - to remove or delete a range of pages. 

Type the number of the first and last pages of the page range in the fields provided. 

 
4. You can then select to Remove or to Delete the page or pages. 

• If you select Remove, the page(s) will be removed from the document, but the TIFF 
file(s) will be retained on your disk. 

• If you select Delete, the page(s) will be removed from the document, and the associated 
TIFF file(s) will be deleted from your system. 

To proceed, click: 
• The Remove button to remove the page or pages, but retain the TIFF file(s). 

or 
• The Delete button to remove the page or pages from the document, and delete the TIFF 

file(s). 

5. When you are finished: 
• Click File in the menu bar, and then click Close to close and save the open document. 

or 
• Click File in the menu bar, and then click Exit to close and save the document and exit 

the Infoprint Scan program. 
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Backing up and restoring Infoprint Scan documents 
You can back up your Infoprint Scan document and then, if necessary, restore the entire 
document or selected pages from the document. 

 
Back up an Infoprint Scan document 
You can make a backup copy of the Scan document that is currently open. 

Notes: 
• An Infoprint Scan document must have been saved at least once before you can make a 

backup copy of the document. 
• If you intend to renumber pages in an Infoprint Scan document, do so BEFORE you create a 

backup of the document. 
(For additional information, see “Renumbering or renaming page files in an Infoprint Scan 
document” on page 130. 

• If you remove a document, you cannot restore individual pages, you can only restore the 
entire document. 
(For additional information, see “Remove or delete Infoprint Scan documents” on page 113.) 

• You cannot restore an Infoprint Scan document that has been deleted. 
(For additional information, see “Remove or delete Infoprint Scan documents” on page 113.) 

To back up the open Scan document: 
1. Save any changes you have made since you opened the document. 
2. Click File in the menu bar, and then click Create Backup. 

 
The backup copy is saved in a directory that is specified by your system administrator.  For 
information about specifying a backup directory, see “Specifying a backup directory” on 
page 132. 
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Restore an Infoprint Scan document 
You can restore a document or selected pages from the latest backup copy of a document. 

Notes: 
• If you remove a document, you cannot restore individual pages, you can only restore the 

entire document. 
(For additional information, see “Remove or delete Infoprint Scan documents” on page 113.) 

• You cannot restore an Infoprint Scan document that has been deleted. 
(For additional information, see “Remove or delete Infoprint Scan documents” on page 113.) 

To restore an Infoprint Scan document: 
1. Click File in the menu bar, and then click Restore From Backup…. 

 
2. In the Restore a previously saved version dialog box select: 

• Document – to restore the entire document. 
• Page list – to specify individual pages, or a range of pages to restore.  In the field 

provided, type: 
− the number of each page, separated by a comma (for example: 2,10,26,40) 

or 
− the beginning and end of a range of pages, separated by a hyphen  

(for example: 13-15) 
or 

− a combination of both (for example: 1-4,10,15,18-23). 
Note: Do not include spaces after the commas. 

• Current Page - to restore backed-up copy of the page that is currently displayed. 

 
3. Click the Restore button. 
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Hints and tips 
The following are a few things that are good to know and will assist you when you are using the 
Infoprint Scan Advanced interface. 

 
Copy changes vs Copy button 
Do not confuse the Copy changes button with the Copy button, as they are very similar:  

• The Copy changes button is located on the left side of the tool bar, within the first group of 
tools.  

 
• The Copy button is located on the right side of the tool bar, within the last group of tools.  

 

 
Scanning Two-Sided Originals 
• If you are using a simplex scanner, and you select Two-sided in the Original area, after the 

front side has completed scanning, you will be prompted to turn over the original hardcopy on 
the scanner so the back side can be scanned. When you are prompted: 
1. Click the OK button in the prompt window.  

 
2. Turn over the original hardcopy in the scanner's document feeder. 
3. Click the Scan button again to begin scanning the back side. 

• If you are using a duplex scanner, and you select Two-sided in the Original area: 
− If your original hardcopy has a standard, predefined paper size (such as, Letter or A4), 

the pages will be turned as they are scanned. 
− If you have defined a custom paper size, after the front side has completed scanning, you 

will be prompted to turn over the original hardcopy on the scanner so the back side can 
be scanned. When you are prompted:  
1. Click the OK button in the prompt window. 
2. Turn over the original hardcopy in the scanner's document feeder. 
3. Click the Scan button again to begin scanning the back side. 
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Selecting multiple files 
When you use Infoprint Scan on a Windows system, as with all Windows applications, Infoprint 
Scan does not necessarily process files in the order in which you select them in the Open dialog 
box. 

• If you use the mouse or click-shift-click to select multiple files, the last file is processed first 
and the first file is processed last. All other files are processed in the order of selection. For 
example, if you select FILE1, FILE2, FILE3, and FILE4 in that order, the processing order is 
FILE4, FILE2, FILE3, FILE1. 

• If you use the Ctrl key on the keyboard to select multiple files, files are processed in reverse 
selection order. For example, if you select FILE1, FILE2, FILE3, and FILE4 in that order, the 
processing order is FILE4, FILE3, FILE2, FILE1.  

• After selection, you can reorder files in the selection list until they appear in the order in which 
you want them to process, as described in "Using the Add Page list box" on page 120. 

 
Using the Add Page list box 
You can add pages to an Infoprint Scan document as instructed in "Adding and replacing pages 
in an Infoprint Scan document" on page 101.  The following are a couple of tips that may assist 
you once you have selected and added the pages to the Add Page list box: 

• To remove a file from the list, highlight the file and click the Remove button. 

• To reorder the files in the list, highlight a file and click the up arrow or the down arrow. 
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Navigating through an Infoprint Scan document 
You can navigate, or page through an Infoprint Scan document using any of the following: 
• The options in the View menu 
• The buttons in the tool bar 
• The light table (see page 122) 

Navigate through a document using View menu options 
Click View in the menu bar, then select from the following options: 

• Next Page - displays the page following the current page of the document. 
• Previous Page - displays the page before the current page of the document. 
• First Page - displays the first page of the document. 
• Last Page - displays the last page of the document. 
• Go to Page... - lets you specify a particular page to display. 

 

Navigate through a document using the buttons in the tool bar 
The following navigation tools are provided in the tool bar: 

 First page - goes to the first page of the document. 

 Previous page - goes to the page immediately preceding the current page. 

 Next page - goes to the page immediately following the current page. 

•  Last page - goes to the last page of the document.  
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Navigate through a document using the light table 
You can use the light table to display small ("thumbnail") representations of all of the pages in the 
document at the same time, in consecutive order, alongside a full-sized, editable view of a 
selected page. 

 

To use the light table: 

1. Click Tools in the menu bar, and then click Light Table.... 

 
All of the pages in the document will be displayed in the panel on the left of the screen.  
Consecutive numbers are displayed above each page.  If there are additional pages in the 
document, use the scroll bar to display the next group of pages. 

2. Click on the page that you want to work with. 
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When a page is selected, the small representation in the left panel will be outlined in red, and 
a full sized view of the page will display in the right panel.  You can use all of the Infoprint 
Scan editing functions on the full size view of the selected page. 

3. To turn off the light table, click Tools in the menu bar, and then click Light Table... again.  
Only the current page will be displayed. 

 
Zooming on pages in an Infoprint Scan document 
You can increase or decrease the magnification of the displayed page in an Infoprint Scan 
document using the Zoom button in the tool bar: 

Note: If you intend to zoom in on a portion of a page for editing, always zoom in on the page 
before you define the rectangular area that you will be working on. 

1. Click the Zoom in View button  to display the zoom tool . 

2. Position the zoom tool where you want to zoom on the page. 

3. To zoom: 
• Click the left mouse button to zoom in on the page.  The magnification of the page is 

increased by one level each time you click the left mouse button. 
• Click the right mouse button to zoom out on the page.  The magnification of the page is 

decreased by one level each time you click the right mouse button. 

4. To deselect the Zoom tool, click the Deselect Tool button . 

 
Specifying units of measure 
You can specify the unit of measure you want to use for edge erase, for the ruler, for cropping or 
trimming pages, and for resizing images.  The unit of measure is changed from the Infoprint Scan 
standard interface. 
1. Start the Infoprint Scan standard interface. 

(If you are currently using the copier interface, click the right mouse button and select 
Advanced.) 

2. In the Infoprint Scan Advanced main window, click Options in the menu bar, and then click 
Preferences.... 
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3. In the Preferences dialog box, click the Layout tab. 

4. In the Units area, select the either the Millimeters or the Inches radio button. 

 
5. Click the OK button. 

Note: The changed unit value will not take effect until you close the current Infoprint Scan 
session and then open a new Infoprint Scan session. 

 
Optimizing halftone scanning for printing as grayscale 
When you scan pages that contain a combination of text and halftone image data you will need to 
zone and rescan as grayscale the portions of the pages that contain the halftone images.  You'll 
achieve the best output results by combining some of the procedures for scanning, zoning, and 
working with layers that were described in previous sections. 

To improve the output appearance of scanned halftones: 

1. Scan the entire page first as a Black and White image. 
a. If this is a new document, follow the basic procedures in "Scan a new Infoprint Scan 

document" on page 7. 
or 
If you're adding a page to an existing document, follow the basic procedures in "Scanning 
to add or replace pages" on page 101. 

b. During the scanning process, you'll access the Scanner Settings dialog box by clicking 
Change Settings in the Scan Document or Append Scan Document dialog box. 
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c. In the scanner settings dialog box: 
• Be sure to select Black and White in the Mode field. 
• Be sure to select 600 in the Dots per inch field. 

  
Fujitsu M4097D 

• Set other scanning options as applicable, as described in "Understanding and using 
the available scanner settings" on page 19. 

• Click OK when you are finished selecting scanning options. 

d. When you have finished setting all scanning options, click Scan in the Scan Document or 
Append Scan Document dialog box to scan the document or page. 

2. If required, set and execute enhancement options for the document or page as described in 
"Enhancing images in an Infoprint Scan document" on page 23.  All image enhancements 
should be done to the black and white scanned images, before you rescan the page as 
grayscale. 

3. If it is not currently displayed, go to the page that contains the area you want to scan as 
grayscale.  For information about going to a particular page, see "Navigating through an 
Infoprint Scan document" on page 121. 

4. Define the area of the page that contains the image you want to scan as grayscale, as 
described in "Zoning pages in an Infoprint Scan document" on page 57. 
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a. During the zoning process, you'll access the Scanner Settings dialog box by clicking 
Change Settings in the zone Scan Settings dialog box. 

 
b. In the Scanner Settings dialog box: 

• Be sure to select 256-Level Gray in the Mode field. 
• Be sure to select 400 in the Dots per inch field. 
• Click OK. 

c. In the Zone Scan Settings dialog box,  

d. Click Rescan to scan just the defined area with the new settings. 

5. After the page has finished rescanning, click Page in the menu bar, and then click 
Remove Zone. 
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6. Click on to select the defined area. 

 
7. Click Edit in the menu bar, and then click Descreen Layer to remove the existing halftone 

screen from the image. 

 
Repeat these procedures for all halftone image areas on the current or other pages of the 
document. 

8. When you have finished rescanning and descreening all halftone image areas, output the 
document in one of the ways described in "Printing Infoprint Scan documents" on page 39. 

Note: You do not need to apply a new screen now in order to print the image.  If you are 
printing on the Infoprint 2000, the appropriate screen will be added at the printer.  If 
you have Infoprint Manager installed and you send the job to the Infoprint server to be 
queued for printing, the appropriate screen will be added at the server. 

9. When you are done: 
• Click File in the menu bar, and then click Close to close and save the open document. 

or 
• Click File in the menu bar, and then click Exit to close and save the document and exit 

the Infoprint Scan program. 
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Placing text and grayscale images on the same page 
You cannot add text to a page in an Infoprint Scan document that has been scanned as 
grayscale.  The following procedure describes what you can do if you need to include both text 
and a grayscale image or images on the same page. 

Note: Adding text to a grayscale page is not a supported function in Infoprint Scan.  This 
procedure is provided as a convenience to users who want to try to achieve the effect of 
adding text to a grayscale page.  The procedure is not supported, and we do not 
guarantee that the results will be exactly what you expect. 

To place text and grayscale images on the same page: 

1. Open a scanned document to the page containing the image scanned as grayscale to which  
you want to add text. 

 
2. Place a sheet of blank paper in the scanner’s document feeder and scan in the sheet in black 

and white mode, at the appropriate resolution.  See “Scanning to add or replace pages” on 
page 101 for information about adding a page to an existing Infoprint Scan document. 

3. After the blank page has been scanned, make the newly scanned page the current page.  For 
information about going to a particular page, see "Navigating through an Infoprint Scan 
document" on page 121. 
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4. Add text to the blank page.  See “Adding text” on page 71 for information. 

 
5. Create a zone at the size of and in the position where you want to place the grayscale image.  

See “Zoning pages in an Infoprint Scan document” on page 57 for information. 

 
6. Place the blank sheet of paper in the scanner’s document feeder again and rescan the zone 

as grayscale.  This will create a grayscale layer on the page. 
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7. Move the previously scanned grayscale image into position in the grayscale layer on the new 
page.  See “Using Infoprint Scan cut, copy, and move functions” on page 85 for information. 

 
8. Delete the page that originally contained the grayscale image that you relocated in the 

preceding step.  See “Remove or delete pages from Infoprint Scan documents” on page 114 
for information. 

9. When you have finished with the open document: 
• Click File in the menu bar, and then click Close to close and save the open document. 

or 
• Click File in the menu bar, and then click Exit to close and save the document and exit 

the Infoprint Scan program. 

 
Renumbering or renaming page files in an Infoprint Scan document 
Scan uses a numbered naming convention for the TIFF files that make up the pages in an 
Infoprint Scan document.  An individual TIFF file is associated with each page.  With certain 
scanners, and as pages are added or deleted, the file names do not always correspond to their 
order in the document.  Though Scan keeps track of where each file, or page, belongs in the 
document, it can be difficult for you to determine which file is associated with which page.  You 
can use Renumber Pages to rename the TIFF files so they are numbered in sequential order 
according to their placement in the document. 

The Renumber Pages option is also useful if, after scanning a multi-page hardcopy document, 
you want to be able to identify and work with individual TIFF files outside of the Infoprint Scan 
application. 

Important! You should not use the renumber function multiple times while you are scanning and 
creating a Scan document.  Renumber only after you have finished scanning and 
inserting pages in a completed document. 

To rename, or renumber the files: 
1. Open the Scan document whose files you want to renumber. 
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2. Click Tools in the menu bar, then click Renumber Pages. 

 
A message window will open, warning you that renumbering will replace the contents of 
certain named files.   

3. Unless you have files with the same name(s) that you do not want replaced, click Yes in the 
message window.  The files are automatically renamed and renumbered in sequential order. 

Notes: 
• Generally, the files named in the message window will be the names of TIFF files that are 

associated with the open document, and are to be renamed and renumbered in sequential 
order.  If you happen to have any other files in the same directory, not associated with this 
open document, that have the same name(s) listed in the message window, you need to 
rename or move these files to another directory before continuing.  Click No in the message 
window to cancel renumbering.  

• If you use a method other than the Renumber Pages option in Infoprint Scan to rename a 
TIFF file that is part of an Infoprint Scan document, the TIFF file will no longer be associated 
with the Infoprint Scan document. 

• If you create a backup copy of an Infoprint Scan document whose pages will also be 
renumbered, renumber the BEFORE you create the backup of the document.  See “Back up 
an Infoprint Scan document” on page 117 for information about backing up documents. 

 
Use caution when renaming or moving files or folders 
If you manually rename or if you move a file or a folder that is supposed to be associated with an 
Infoprint Scan document (referenced in a job ticket), the association with the job ticket, and, 
therefore, with the Infoprint Scan document will be severed. 
Note: If you rename an Infoprint Scan document (TIFF) file using the Renumber Pages option, 
the file’s association with the job ticket will remain intact.  For additional information, see 
“Renumbering or renaming page files in an Infoprint Scan document on page 130. 

 
Using Send to Acrobat 
You can use the Send to Acrobat menu item to create a PDF file of the current Infoprint Scan 
document.  

To create a PDF file of the open Infoprint Scan document, click File in the menu bar, and then 
click Send to Acrobat. 
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Adobe Acrobat will open with the PDF displayed.  The PDF file can then be viewed and 
manipulated with Adobe Acrobat.   

Notes:  
• When a PDF file is created from Infoprint Scan using Send to Acrobat, all white areas, or 

white pixels in the PDF file will actually be transparent. 
• You can also create a PDF file in Infoprint Scan using the Export function.  For information, 

see “Export an Infoprint Scan document as a PDF file” on page 53. 

 
Specifying a backup directory 
An Infoprint Scan system administrator can specify a directory where backup copies of Infoprint 
Scan documents are to be stored.  (For information, see “Backing up and restoring Infoprint Scan 
documents” on page 117. 

To set the backup directory, include the following line in the InfoPrint.ini file: 
Source_Dir=<BackupDirectoryName> 

  where <BackupDirectoryName> is the name and path of the directory where you want the 
backup files to be stored. 

Notes: 
• The InfoPrint.ini file is located in the directory where Infoprint Scan is installed.  (The default 

location is C:\Program Files\Ibm\Infoprint.) 
• The line must be inserted in the ini file under the Scan heading.  The InfoPrint.ini will look 

similar to the following after the line is inserted: 

[Scan]
custompagesize=0
length=1100
width=850
Source_Dir=D:\ScanBackup
[GAMMA]
gamma_file=c:\Program Files\IBM\Infoprint\lstar.pxg 

• If a backup directory is not specified in the InfoPrint.ini file, one will be created 
automatically after an operator first selects to create a backup.  The line 
Source_Dir=..\Source will be added to the InfoPrint.ini file at that time, making Source the 
default backup directory, created as a subdirectory in the directory where the job ticket is 
stored. 
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Part II.  The Infoprint Scan Copier Interface 
The procedures in Part II of this guide are applicable only when you are using the Infoprint Scan 
Copier interface.  If you are using the Advanced interface, refer to “Part I.  The Infoprint Scan 
Advanced Interface,” beginning on page 3, for information. 

With the Copier interface, Infoprint Scan provides an alternative interface that you can use for 
scanning and printing hardcopy documents.  This is a simplified version of the Advanced program 
that includes a copier-like interface that is designed for use with a touch screen monitor.  If you do 
not have a touch screen monitor, you can still use a mouse to select options and perform 
scanning and printing operations. 

The Copier interface provides a subset of the functions that are available in the Infoprint Scan 
Advanced interface.  You can set options for paper size, sides for scanning and printing, and 
specify the image type of the hardcopy original document.  Enhancement options include image 
shift, edge erase, page numbering, and booklet making.  For finishing, you can select which 
output stacker to use on the selected printer, specify stapling options, and turn edge trimming on 
or off for booklets.  For small documents (those that comprise 50 or fewer sheets of paper), you 
can scan and print with one push of a button. 

To get started, be sure your display screen properties are set correctly, as described in “Before 
you begin,” and then continue with “Using the Copier interface” on page 137. 

If you require more advanced capabilities for setting up your scanner and printer and for image 
enhancement than are available in the Copier interface, then you should use the Advanced 
interface. 

 

Before you begin 
Before you open Infoprint Scan and begin to use the Copier interface, you need to be sure that 
your display screen is set up for optimal performance.  You need to: 
• Specify display screen properties, as described on page 133.  
• Hide the Windows task bar, as described on page 135. 

Maximize the Infoprint Scan display window, as described on page 136. 

 
Specify display screen properties 
1. On your Windows desktop, click the right mouse button, and then click Properties in the pop-

up menu. 
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2. In the Display Properties window: 
a. Click the Screen Saver tab and select (None) in the Screen Saver drop-down menu. 

 
b. Click the Settings tab and specify the following: 

• In the Color palette drop-down menu, select one of the following (depending on 
which is available in your menu): 
− True Color 
− 16777216 Colors 
− 32-Bit 

• Use the slide bar to specify 1024 x 768 pixels for the screen resolution. 
• Select 70 Hertz in the Refresh Frequency drop-down menu. 
• Click the Text button. 

− In the Testing Mode window, click the OK button. 
− After a successful test, click the Yes button in the Testing Mode window in 

response to Did you see the bitmap properly? 

 
3. In the Display Properties window, click the OK button. 
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Hide the Windows task bar 

• The Infoprint Scan Copier interface uses the entire display area of your screen. If the 
Windows taskbar is visible at the bottom or side of your desktop, it can interfere with the 
display of the Copier interface.  Before you start the Infoprint Scan Copier interface, you need 
to hide the taskbar: 

1. Position the mouse cursor in a blank area of the taskbar and click the right mouse 
button. 

 
2. Click Properties with the left mouse button. 

 
3. In the Taskbar Properties dialog box, check the Auto hide checkbox. 

 
4. Click the OK button. 
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Maximize the Infoprint Scan display window 

You will also get the best results if you maximize the display window.  Do this when you open the 
Infoprint Scan Advanced interface to initiate the Copier interface for the first time, as instructed in 
“Starting the Infoprint Scan Copier interface” on page 138: 
1. Open Infoprint Scan. 
2. In the Advanced interface main window, maximize the window by doing either of the 

following: 
• Click the Infoprint Scan icon, located in the left corner of the title bar, and then click 

Maximize. 
or 

• Click the Maximize button, located at the right of the title bar. 

    or     
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Using the Copier interface 

Notes: 
• If the workstation where Infoprint Scan is installed has a touch screen monitor, general user 

operations in the Copier interface may be done using touch only.  (Or, if you prefer, you do 
have the option of using a mouse.)   

• The administrative tasks of switching to the Advanced interface, specifying scanner settings, 
and exiting the Copier interface, can only be done using a mouse and keyboard.  

The following topics provide information about the Infoprint Scan Copier interface: 
• "Starting the Infoprint Scan Copier interface” on page 138 - describes how to open the 

Copier interface.  
• "Scanning and printing” on page 140 - describes how to use the functions of the Copier 

interface to scan and print a document.  
• "Specifying copier settings” on page 149 - describes how to specify default settings for 

the Copier interface. 
• “Specifying Setup, Finish, and Enhance options” on page 144 – describes how to tell the 

system about the hardcopy document you will scan, and the appearance of the final 
output. 

• "Recovering from a paper jam” on page 154 - describes what to do to resume scanning 
after a paper jam.  

Important: Be sure to read the following tips - they include helpful information for using the 
Infoprint Scan Copier interface. 

Tips:  
• Help for using the Infoprint Scan Copier interface is displayed at all times in the lower 

right area of the interface. 

• When you are using the Infoprint Scan Copier interface with a Fujitsu M4097D scanner, 
be sure to position the pages face down in the automatic document feeder.  When you 
put a letter size hardcopy page in the automatic document feeder or flat on the glass for 
manual scanning, be sure to place the page face down with the long (bind) edge of the 
paper leading.  For larger paper sizes, insert the sheet with the short edge leading. 

• For security purposes, the scanned pages are not saved on your system after the 
scanning and printing process is completed for a document. 

• When the Infoprint Scan Copier interface is active, click the right mouse button and then 
click Advanced with the left mouse button to switch to the Advanced interface.  

 
• To close the Infoprint Scan program from the Copier interface: 

− Click the right mouse button and then click Exit with the left mouse button.  

 
or  

− Press the Alt+F4 keys on the keyboard.  
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Starting the Infoprint Scan Copier interface 
You can start the Copier interface from an open Infoprint Scan Advanced interface session, or 
you can specify to start the Copier interface first when Infoprint Scan is started.  

Starting the Copier interface from the Advanced interface 
Note: The first time you use the Copier interface, you must start it from the Advanced interface. 

To start the Copier interface from the Advanced interface:  
1. Start Infoprint Scan. 
2. In the Advanced interface main window, if you have not already done so, maximize the 

window by doing either of the following: 
• Click the Infoprint Scan icon, located in the left corner of the title bar, and then click 

Maximize. 

  
or 

• Click the Maximize button, located at the right of the title bar. 

 
3. Click Options in the menu bar, and then click Copier. 
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Note: You cannot access the Copier interface if there is an open document displayed in the 
Advanced interface. If a document is open, be sure to close the document before continuing. 
To close an open document in the Infoprint Scan Advanced interface, click File in the menu 
bar, and then click Close. 

 

Starting the Copier interface first when Infoprint Scan is started 
You may want Infoprint Scan to start the Copier interface first if it is the primary Infoprint Scan 
interface that you will be using. 

To open the Copier interface first when Infoprint Scan is started: 

1. Start the Infoprint Scan Advanced interface, then click Options in the menu bar, and then 
click Copier Settings....  

 
or 
From the Infoprint Scan Copier interface, click the right mouse button and then click Settings 
with the left mouse button.  

 

2. In the Copier Settings dialog box, select the On radio button for Copier Autostart.  
(To start Infoprint Scan with the Advanced interface, select the Off radio button.)  
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3. Click the OK button to save this setting and close the dialog box.  

Note: This and any other modified settings will take effect the next time you start Infoprint 
Scan, restart the Copier interface, or click the Reset button on the Copier interface.  

 
For information about setting other options for the Infoprint Scan Copier interface, refer to 
"Specifying copier settings” on page 149. 

 
Scanning and printing 
When you are ready to scan a hardcopy document using the Infoprint Scan Copier interface, the 
first thing you need to do is determine whether you have a large job or a small job. You make this 
determination based on how many sheets of paper will fit in the document feeder of your scanner.  
For example, the document feeder of the Fujitsu M4097D scanner will hold approximately 50 
sheets of paper at one time. So, when you are using the Fujitsu M4097D scanner: 

• A small job is a hardcopy original document that consists of up to 50 sheets of paper. The 
entire original document can be placed in the document feeder and can be scanned and 
printed in one step. Refer to "Scanning and printing a small job” on page 140 for information. 

• A large job is a hardcopy original document that consists of 50 or more sheets of paper. The 
document must first be scanned in separate stacks of up to 50 sheets, until all of the pages 
have been scanned, and then the entire document can be printed at one time. Refer to 
"Scanning and printing a large job” on page 142 for information. 

Scanning and printing a small job 
Note: When you follow the instructions for a small job, your document will be scanned and 
printed in one step. If you want to view the scanned document online, run a proof print, and make 
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any additional modifications to the scanned document before final printing, you can follow the 
instructions in "Scanning and printing a large job” on page 142, even if your document comprises 
fewer than 50 sheets of paper. 

To scan and print a small job: 

1. Place the hardcopy original document in the scanner's multi-sheet document feeder.   
(For the Fujitsu M4097D scanner, position the pages face down.  For letter size paper, insert 
the sheet with the long (bind) edge leading.  For larger paper sizes, insert the sheet with the 
short edge leading.) 

2. Press to highlight the SMALL job on the toggle switch. 

 
3. Use the numeric keypad to specify the number of copies you want to print. 

 
Tip: Press the Clear (C) key to reset the number of copies to 1. 

4. Press each of the tabs in the notebook section of the interface to set options for Setup, 
Finish, and Enhance.  

 
Go to "Specifying Setup, Finish, and Enhance options” on page 144 for information about 
each of the options you can set. 

5. Press  to scan and print the document.  

Note: If a paper jam occurs while you are scanning the document, go to "Recovering from a 
paper jam” on page 154 for instructions. 

6. When the document has finished printing:  
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a. Select  if you want to view, modify, proof, and reprint the current job, 
then continue with step 3 on page 142 of  "Scanning and printing a large job," 
or  

b. Press  to clear the viewport and return all settings to their original values. 

Scanning and printing a large job 

To scan and print a large job: 

1. Place the first 50 sheets of paper in the scanner's multi-sheet document feeder. 
(For the Fujitsu M4097D scanner, position the pages face down.  For letter size paper, insert 
the sheet with the long (bind) edge leading.  For larger paper sizes, insert the sheet with the 
short edge leading.) 

2. Press to highlight the Large job on the toggle switch. 

 

3. Press  to scan the first 50 sheets. 

4. Place the next 50 sheets in the scanner's multi-sheet document feeder. 

5. Repeat steps 3 and 4, as necessary, until all of the pages of the hardcopy original document 
are scanned.  

Note: If a paper jam occurs while you are scanning the document, go to "Recovering from a 
paper jam” on page 154 for instructions. 

6. Press each of the tabs in the notebook section of the interface to set options for Setup, 
Finish, and Enhance.  

 
Go to "Specifying Setup, Finish, and Enhance options” on page 144 for information about 
each of the options you can set. 

7. The last page scanned will be displayed in the viewport.  
• Use the buttons below the viewport to page through and check the scanned document, 

and, if required, to add or delete pages. These buttons are described in "Using the 
viewport buttons” on page 155. 

• If necessary, repeat step 6 to make further modifications. 
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8. Press  to print a single proof copy of all scanned pages.  
If necessary, repeat step 6 to make further modifications. 

9. Use the numeric keypad to specify the final number of copies you want to print. 

 
Tip: Press the Clear (C) key to reset the number of copies to 1. 

10. Press  to print the final copies of the document. 

11. When the document has finished printing:  

a. Select  again to view, modify, proof, and reprint the current job. 

or  

b. Press  to clear the viewport and return all settings to their original values. 
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Specifying Setup, Finish, and Enhance options 
Press each of the tabs in the notebook area of the Infoprint Scan Copier interface to set options 
for Setup, Finish, and Enhance. 

•  
Use Setup to specify information about the document that you are going to scan and print.  

1. Paper size - press the size that matches the input and output size of the document.  

 
If the corresponding size is not displayed, press More..., then highlight the appropriate 
paper size and press OK.  

 

The selected paper size will now be displayed on the interface. 
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2. Sides - press to cycle through your options and select how the input document is printed, and 
how the scanned output will be printed:  

 Select if the original hardcopy is printed simplex (1-sided), and the scanned 
output will be printed simplex.  

 Select if the original hardcopy is printed simplex, and the scanned output 
will be printed duplex (2-sided).  

 Select if the original hardcopy is printed duplex, and the scanned output will 
be printed simplex.  

 Select if the original hardcopy is printed duplex, and the scanned output will 
be printed duplex.  

3. Image type - Press to specify the composition of your original hardcopy document. This will 
optimize the scanning process for the input data.  

 Select if your input document is composed primarily of a combination of text and 
graphics. 

 Select if your input document is composed primarily of text only.  

•  

Use Finish to specify what finishing options you want to apply to the scanned document 
when it is printed. 

Press on the area of the graphic that corresponds to the output bin you want to use. The 
selected output location will be highlighted with a green outline.  For example, the Stapler is 
selected in the following illustration.  

 

Options include: 
1. Stacker - Use this to specify the location on the printer where you want to send the 

printed output. A graphic of your printer and its available output bins is displayed. Only 
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those output bins specified for your printer in step 5 on page 150 of "Specifying copier 
settings" are available.  

2. Staples - This is only available when you select a printer output bin that supports 
stapling. Press to select a stapling option. For example, the following options are 
available for the Infoprint 2000 stapler:  

 Select if you do not want the printed output to be stapled. 

 Select to put one staple in the upper left (bind) margin. 

 Select to put one staple in the lower left (bind) margin.  
(This is most often used when the document has a horizontal, or landscape 
orientation.) 

 Select to put two staples, one in the upper left and one in the lower left margin.  

3. Edge trim - This is only available when you select the Infoprint 2000's booklet maker for 
the output location. Press to specify whether you want to trim the edges of printed 
booklets. If you select to turn edge trimming on, the edges will be trimmed by the amount 
previously set on the booklet maker itself.  

 Select to turn edge trimming Off. 

 Select to turn edge trimming On. 

•  
Use Enhance to specify options to improve the appearance of your scanned document.  

1. Image shift - Use this to shift the page image a specified increment to the right to allow 
for a wider margin for binding or hole punching. For duplex printing, this function will 
adjust back pages to shift to the left the same amount as the front pages. Press to select 
the amount to shift the page image: 

  Select if you do not want to shift the page image. 
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 Select to shift the page image 1/5 inch. 

 Select to shift the page image 2/5 inch. 

 Select to shift the page image 3/5 inch. 

 Select to shift the page image 4/5 inch. 

 Select to shift the page image 1 inch. 

2. Edge erase - This will eliminate an unwanted black border, marks, specks, or other data 
from around the page margins. An example of such unwanted data is the "shadows" that 
may be left when you scan three-hole punched pages. The width of the area that will be 
erased around the edges is specified in step 7 on page 151 of "Specifying copier 
settings."  Press to select the edge erase option you want to use: 

 Select if you do not want to activate the edge erase function. 

 Select to erase the data evenly around all four edges. 

 Select to erase the data around all edges, adjusting for a wider margin on the 
bind edge. The back page is adjusted for duplex printing. 
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3. Page numbering - This will add page numbers to a specified position at the bottom of 
each page of the scanned document. Press to select the position of the page numbers:  

 Select if you do not want page numbers added to the scanned pages. 

 Select to add a page number at the bottom, left side of each page. The position 
of the page number is adjusted on the back pages for duplex printing. 

 Select to add a page number at the bottom, center of each page.  

Select to add a page number at the bottom, right side of each page. The position 
of the page number is adjusted on the back pages for duplex printing. 

4. Booklet layout - Use this to print your scanned pages 2-up. With this function, two pages 
print side-by-side on each side of a physical sheet of paper, ordered appropriately so that 
the output can be folded and stapled down the middle. The Infoprint Scan 2000 program 
will determine the output paper size by doubling the dimensions of the input paper size 
that you selected in the Setup options. Press to select whether you want booklet layout 
function turned Off or On:  

 Select to turn Off the booklet layout function. 

 Select to turn On the booklet layout function. 

Note: The booklet layout function is not automatically tied to an output location on your 
selected printer. To have the finished booklet saddle-stitched (stapled on the fold 
of the booklet), you must be sure to select the corresponding output location and 
stapling options in the Finish tab.  
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Specifying copier settings 
Use the copier settings to specify the values that will be used as default settings for the Infoprint 
Scan Copier interface.  

Note: Although general user operations in the Copier interface may be done by touch if the 
workstation where Infoprint Scan is installed has a touch screen monitor, to specify 
scanner settings you must always use a mouse and keyboard.  

To specify default settings for the Infoprint Scan Copier interface:  

1. Open the Copier Settings dialog box by doing one of the following: 

a. From the Infoprint Scan Advanced interface, click Options in the menu bar, and then 
click Copier Settings....  

 

or  
b. From the Infoprint Scan Copier interface, click the right mouse button and then click 

Settings with the left mouse button.  

 

2. In the Copier Settings dialog box, click the arrow in the Printer field to highlight the printer 
type that you will use to output your scanned copies.  
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3. Move the Reset Timeout slide bar to specify the number of minutes you want the Copier 
interface to wait idle before modified settings are automatically reset to their default values. 
The default value is Off. 

 

If you do not want modified settings to reset automatically, set the slide bar to Off to disable 
this function. 

4. For Copier Autostart, select one of the radio buttons:  
• On - to specify that the Copier interface will be started automatically when the Infoprint 

Scan program is started. 
• Off - to specify that the Infoprint Scan Advanced interface will be started first when the 

Infoprint Scan program is started. To start the Copier interface from the Advanced 
interface, click Options in the menu bar, and then click Copier.  

 
5. In the Printer Features list box, highlight the finishing options that are installed on your printer. 

The selected options will determine the choices that are available when you select the Finish 
tab on the Copier interface. You may highlight one or more, or none of the options. The 
default is no finishing options.  

 

6. In the Options list box, check one or more, or none of the options:  

• Deskew - when this is activated (checkbox checked) the program will automatically 
deskew all scanned pages. By default, Deskew is not activated.  

FYI: Skew occurs when paper goes through the scanner's paper path at a slight angle, 
causing the scanned lines to be improperly aligned. Deskew adjusts and corrects the 
angle at which a document is skewed, so the page and lines will be aligned properly.  
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• Offset Stack - when this is activated, copies of printed jobs will be stacked offset from 
each other.  Offset stacking is only supported if this feature is also supported for the 
output location specified on the printer on the Finish page of the Copier interface.  By 
default, Offset Stack is not activated.  

 

7. In the Edge Erase Margin field, type the width of the margin where the black border, black 
marks, or black specks around all edges of pages will be eliminated when this function is 
activated on the Enhance page of the Copier interface.  The range is .01 to 10 inches, with a 
default setting of .25 inch.  

(See "Changing the unit of measure” on page 153 to find out how to specify millimeters 
instead of inches for the unit of measure.) 

8. In the Bind Erase Margin field, type the width of the margin where the black border, black 
marks, or black specks on the bind edge of pages will be eliminated when this function is 
activated on the Enhance page of the Copier interface.  The range is .01 to 10 inches, with a 
default setting of .5 inch.  

(See "Changing the unit of measure” on page 153 to find out how to specify millimeters 
instead of inches for the unit of measure.) 

 

9. The Supported Papers list box lists all of the paper sizes/types supported by the workstation's 
printer driver. Based on their frequency of use, select three of these papers to include in the 
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Favorite 3 Papers list box. The papers listed in the Favorite 3 Papers list box will be displayed 
for selection on the Setup page of the Copier interface. To select your favorite papers:  
a. Highlight one of the papers in the Supported Papers list box. 
b. Click the Add button. 
c. Repeat steps a and b until three papers are listed in the Supported Papers list box.  

(To remove a paper from the Supported Papers list box, highlight the paper and click the 
Remove button.)  

 
10. Click the OK button to save your settings and close the dialog box.  

Note: The new settings will take effect the next time you start Infoprint Scan, restart the 
Copier interface, or click the Reset button on the Copier interface.  

 
Tip: Before you save your modified settings, you can click the Cancel button to cancel your 
changes and close the dialog box.  
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Changing the unit of measure 
You can change the unit of measure (from inches to millimeters or from millimeters to inches) for 
the edge erase and bind erase margins that you set in the Copier Settings dialog box. You can 
only do this from the Infoprint Scan Advanced interface. 

1. Start the Infoprint Scan Advanced interface.  
(If you are currently using the Copier interface, click the right mouse button, and then click 
Advanced with the left mouse button.)  

 
2. In the Infoprint Scan Advanced main window, click Options in the menu bar, and then click 

Preferences....  

 

3. In the Preferences dialog box, click the Layout tab.  

4. In the Units area, select the either the Millimeters or the Inches radio button.  

 

5. Click the OK button. 
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6. To return to the Infoprint Scan Copier interface, click Options in the menu bar, and then click 
Copier.  

 

 
Recovering from a paper jam 
If a paper jam occurs while you are scanning a document, you should not have to rescan the 
entire job. In most cases, the recovery procedure is as follows, depending on whether you are 
scanning a small job (up to 50 total sheets of paper) or a large job (more than 50 sheets of 
paper). 

• If a paper jam occurs while you're scanning a job as described in "Scanning and printing a 
small job” on page 140  

1. Be sure that the last page successfully scanned is currently displayed in the viewport.  
(Go to "Using the viewport buttons” on page 155 for information about paging through the 
scanned, displayed document.) 

2. Restack all remaining unscanned sheets in their original order in the document feeder. 

3. Press  to resume scanning. 

• If a paper jam occurs while you're scanning a job as described in "Scanning and printing a 
large job” on page 142: 

1. Be sure that the last page successfully scanned is currently displayed in the viewport.  
(Go to "Using the viewport buttons” on page 155 for information about paging through the 
scanned, displayed document.) 

2. Restack all remaining unscanned sheets in the current stack of 50 sheets in their original 
order in the document feeder. 

3. Press  to resume scanning. 
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Using the viewport buttons 

• Use the navigation buttons below the viewport to page through and check the scanned 
document.  

 Press to display the first page of the document. 

 Press to display the previous page (1 page before the currently displayed page).  

 Press to specify which page you want to display. 

 Press to display the next page. 

 Press to display the last page of the document. 

• Use these buttons to add or delete displayed pages:  

 Press to insert a blank page after the currently displayed page. 

 Press to delete the currently displayed page. 
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